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Module Title: Operating a Personal Computer
LG Code AGR BAN1 M17 0919
TTLM Code: AGR BAN1 TTLM17 0919

LG 69:- Start computer, system information and
features

LG Code: AGR BAN1 MO07 LO1-LG-69

LG 70:- Navigate and manipulate desktop
environment

LG Code: AGR BAN1 M07 LO2-LG-70

LG 71:- Organize files using basic directory and
folder structures

LG Code: AGR BAN1MO7 LO3-LG-71

LG 72:- Print information
LG Code: AGRBAN1MO7 LO4-LG-72

LG 73:- Shut down computer
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AGR BAN1 MO7 LO5-LG-73

Instruction sheet

Learning Guide # 69

This learning guide is developed to provide you the necessary information regarding the
following content coverage and topics:

¢ Adjusting work space, furniture and equipments to suit ergonomic requirements..

¢ Ensuring OHS requirements in work organization.

e Starting/logging a computer.

e [dentification basic functions and features.

¢ Customizing desktop configurations.

e Using help functions

This guide will also assist you to attain the learning outcome stated in the cover page.
Specifically, upon completion of this Learning Guide, you will be able to:-

Start computer, system information and features

Navigate and manipulate desktop environment

Organize files using basic directory and folder structures

Print information

Shutdown computer
Learning Instructions:

a. Read the specific objectives of this Learning Guide.

b. Follow the instructions described

c. Read the information written in the information “Sheet

d. Accomplish each “Self-check respectively.

e. If you earned a satisfactory evaluation from the “Self-check” proceed to the next or

“Operation Sheet
f. Do the “LAP test”
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Information Sheet-1

ergonomic requirements

Adjusting work space, furniture and equipments to suit

1.1 Computer class room arrangement

Preparing convenient computer lab room is the first task to be done so that trainees will
gain the required skills properly. before preparing computer room the following points
has to be considered:

Building consideration

e What is the size of your new or existing learning space?

e How many students will be utilizing the space?

e Will power be accessed from the floor, the ceiling, the walls, or from the furniture

itself?

e Are there doors, windows, columns, heater vents, and other items that need to be

designed around?

e Are dimmable lighting or light-blocking window treatments required for some

classrooms?

Classroom consideration

e Will computers or technology equipment be placed on top of work surfaces, or

mounted below?

e What items will be used individually or shared?

e How many are needed? Computers, CAD stations, tablets?

e Do the lessons emphasize students working independently or as part of a group?

e What size groups?eWill students gather at a staging area, or a central location, before

breaking into groups for project work?
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e Are accessories like monitor arms, CPU holders, or keyboard trays desired?

Teacher consideration

e What type of desk does the instructor need?

e A desk with student meeting space?

e Built-in outlets or accessible power?

¢ A mobile cart with power?

e Will the teacher present lectures, requiring a lectern, or is all instruction
collaborative — or is there a blend of the two?

e What type of technology will the instructor employ regularly?

e Whiteboard, computer, or projection technology?
Student consideration

e What age are the students?

e Five, eleven, seventeen?

e What seat or workstation heights will work best?

¢ Do students have backpacks or other materials with them that require classroom
storage?

e C(Can students see everything clearly?

e From the population’s average height, are their sight lines clear?

¢ Do students have portable devices that require charging?

The following are some of the class room styles convenient for teaching learning process

a) Perimeter classrooms

With workstations arranged along the walls, perimeter labs allow teachers to easily
makeover around the classroom and manage student work. Teachers can easily keep an eye
on what a large number of students are working on, and students can quickly turn around

when the teacher needs to make a presentation.
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Features of perimeter style classroom

v" Layouts shown below are for 22 students

v’ Chase Wire Management System

v' Varied panel heights; they can match work surface height, rise above work surface to

define workspaces, or be even higher to create a shelf as pictured at right.

v" Popular work surface heights: 25", 27", or 29"

Perimetar without Backsplash

b) Lecture classroom

Classrooms with students arranged in rows are the classic layout, and that is because

many subjects are best taught with instructors leading the class. Lecture layouts allow

students a clear view of the teacher without having to turn around, teachers can easily see

when a student has a question, and the front of the classroom can be used to work or

project lessons onto a screen.

Features of Lecture-Style Classrooms:

v" Layouts shown below are for 30 students

v’ Chase Wire Management System

Federal TVET Agency
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v’ Varied panel heights; they can match work surface height, rise above work surface

to define workspaces, or be even higher to create a secure testing space.

v" Popular work surface heights: 25", 27", or 29"

Perimeter without Backsplash

c) Back-to-Back classrooms

Back-to-back layouts are similar to lecture layouts, but allow many students to fit in a

relatively small footprint. Often, these classrooms have split uses — one area for non-

computer-based work, and another for working with technology. Teachers might not do

much lecturing because some students may be facing away from them, but the students do

have the ability to easily interact with fellow classmates.

Features of Lecture-Style Classrooms:

v Layouts below are for 30 students; layout above is for 28 students

<\

Chase Wire Management System

v Varied panel heights; they can match work surface height, rise above work surface to

define workspaces, or be even higher to create a secure testing space.

v Popular worksurface heights: 25", 27", or 29"
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D) Flexible Designs
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Every instructor has a teaching style or idea for how they want to teach, and Interior

Concepts has stepped up to the plate with layouts and workstation designs that can be

personalized for your space and learning environment. With our ability to design our

workstations by the inch, we can also build our stations to fit your unique room layout,

accommodating doors, window ledges, and columns.
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Self-Check -1 Written Test
Name: Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid

some explanations/answers.

1.  Explain briefly about the following styles of computer class room arrangement.

a) Perimeter classrooms

b) Lecture classroom

c) Back-to-Back classrooms

2. What are the considerations to be taken to make a convenient computer class room?

Note: Satisfactory rating - 10 points and above

You can ask your teacher for the copy of the correct answers.

Unsatisfactory - below 10 points

Answer sheet

Score =

Rating:
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Information Sheet-2 | Ensuring OHS requirements in work organization.

OHS guidelines related to the use of the screen equipment, computing equipment and
peripherals, ergonomic work stations, security procedures, customization requirements

® Statutory requirements

Computer care

We should have to take care of our computer from damage. A computer can cause problems both on

the hard ware & software. So, to protect it from damage

A.

Provide the best possible environment both
physically & electronically for the computer
Physical like, ambient temperature, dust & smoke conditions.
Electronically concerns are like sudden increase in an electric voltage & lightning. To
overcame this problem we use devices like UPS (uninterrupted power supply) w/c can
tolerate large voltages

Virus protection & detection
Viruses are software w/c prevent the computer from performing tasks in the right way.
A virus can be transmitted in to our computer by d/t meanness like floppy diskettes, flash
disk, through computer networks etc.
To prevent our computer from viruses. We should use or install Anti-virus software & we
should frequently update our anti viruses.

There is no way that viruses can damage computer hardware
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Self-Check -1

Written Test

Name:

Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid

1. What measures to be taken to protect a computer from virus? Explain

Note: Satisfactory rating - 10 points and above

some explanations/answers.

You can ask your teacher for the copy of the correct answers.

Unsatisfactory - below 10 points

Answer sheet

Score =

Rating:
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Information Sheet-3

Starting/logging a computer.

What is a computer?

A computer is an electronic device, operating under the control of instructions stored in its

own memory that can accept data (input), process the data according to specified rules,

produce information (output), and store the information for future use

Historical overview of computers

In the early days man used to count with his fingers and manipulated numbers manually.

Technology development demand faster computing devices. This led to the development of

computers. The Abacus, Pascal’s calculator and the personal computer are some of such devices

separated by thousands of years of history.

Computer technology is under continuous improvement and the general trend from earliest

generations to the latest generations is enumerated as follows.

Characteristics of computers

Are getting lesser in volume size

Are getting more reliable

Are getting cheaper in price

Consume less power

Better life span & Have larger memory capacity

Have better execution speed

Better programming capabilities

Simpler maintenance schedules
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The main characteristics of computers that have made them so powerful and useful are:

+ Speed:

>

Computers can perform tasks within a matter of seconds.

-6
Their speed is measured in second, micro second (10 one millionths), nanosecond

(10_9 one billionths), and Pico second (10_12 one trillionths).

Hence a computer with speed 1 microsecond can perform 1 million instructions in 1

second.

« Accuracy and Reliability: A computer is extremely fast and perfect in reliability and

accuracy. Since computers have tremendous accuracy, they function without error.

However, it must be remembered that the computer is capable of doing only what it is

instructed to do. If faulty instructions are provided for processing data, obviously, faulty

answers will be given. This is called GIGO (garbage in garbage out).error free.

+ Consistency (Diligence): computers operate and process data over long period of time.

Unlike human being, computers being machines are highly consistent, are free from

monotony, tiredness, lack of concentration, etc

+ Storage Capacity: computers can store huge amount of data. Once recorded a piece of

information is never forgotten (unless some problems takes place) and information can be

retrieved almost instantaneously. A single CD ROM can contain the entire Encyclopedia

Britannica and more!

% Flexibility or versatility (Programmability): Computer is a versatile machine. A computer is

perhaps the first general-purpose machine devised by man. All other machines like TV,

typewriter, radio, etc do one thing they are designed for, nothing more nothing less. Unlike

this, a computer can be used to play music, type letters, send faxes, and diagnose illness, design

buildings and bridges, etc, provided that it is given the right set of instructions to do the job.

Y/

Y/

manner e.g. payroll system

Application of computers

Computers can be applied in:

+ Volume- handle large amount of data

+ Repetitiveness - suitable for processes that represent themselves in a predetermined

Page 13 of
125

Federal TVET Agency
Author/Copyright

Basic Agricultural Production and Natural

Resources Conservation Level-I

Version -1
October 2019




Health and medicine
Education and training
Business and commerce
Science and engineering
Manufacturing

Aviation and space control
Sports and entertainment

Library and documentary

Transport and communication

Weather & environment routing & dangerous tasks

Shopping from home

Information utilities and so on.

In general computers can be applied in every walk of human life. So we can say computers are the

power tools of the modern society.

Why we need to study computer science?

Because it is more powerful than humans in speed, accuracy tireless attention (to speed up

problem solving and increase productivity, increase efficiency, higher quality , improved safety,

and better service ) even though human is superior in creativity , judgment and intuition. In

other words to study computer science is not preference, it is mandatory, because today

computer is important in every walk of human life such as at home, at school, at office, at space

and so on.

Limitations of Computers

Although computers can be applied in different areas, there are activities that computers can’t

perform. Some of them are:

a.Computers can’t decide how to be programmed. It is always humans that are responsible

for programming the computers.

b.Computers do not provide their own inputs unless people provide it with the inputs.

Interpretation of data and implementation of decisions is always left for humans. That is a
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computer does not interpret the information it produces based on the information

obtained unless it is programmed.

Generation of Computers

The main criteria to distinguish generation of computer are:-

Dominate types of electric circuit element that used
Major secondary storage device

Computer language

YV V VYV V

Types of characteristics of operating system
» Memory access time (time to store or retrieve a word of data from the memory)

1. First Generation Computers (1940-1959):

> Used vacuum tubes

> Punched cards were the main source of inputs

> Magnetic grams were used for internal storage

> Operate in a speed of milliseconds

> Could handle more than 10,000additions per

second

Vacuum tubes

. Are large in their nature

. Consume a great deal of electricity
] produce a lot of heat

] Are prone to failure

The shortcomings of the first generation are:

<> Slow on function.

<> Low level of accuracy and reliability.

< High power consumption.

<> Machine breakdown rate was very high.
R Fault finding was difficult

R Too big in size

R Expensive.

2. Second Generation Computers (1959-1965):
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e Transistors were their main circuit components
e Invented by Bell Labs
e Uses magnetic tapes as main storage

e Operate in a speed of Micro seconds

Transistors had the following on their credit side: - They

A Are smaller
A More reliable
a Use less electric energy
A Generate little heat
— In addition Computers with transistors could operate much faster than those with

vacuum tubes.

3. Third Generation Computers (1965-1972):

- Era of microelectronics

= Invention of Integrated circuits(IC)

. Data storage switched from magnetic cores to
Integrated circuit boards.

" New input/output(l/0) methods such as optical
scanning & plotters

Other advantages of this generation over the second generation includes:-

. Better storage devices

) Improved I/0 devices

) Low cost of auxiliary memory or storage device

4. Fourth Generation computers (since 1970):

<> Generally expanded storage capabilities &
improved circuitry

<> Has large scale integrated circuits (LSI) very LSI

< Operate at a speed of nano seconds

R Thousands of transistors on a single silicone chip.

R This generation is also called the micro
generation as a result of the introduction of the micro processors

Other advantages of 4th generation are:-
Page 16 of Federal TVET Agency |Basic Agricultural Production and Natural
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5. Fifth Generation Computers:
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More compact size (minimized)
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Much faster

More accurate and reliable

More memory and storage capacity

Better interface b/n user and computer

Is still in progress

These computers will have intelligent processers

Computers of this generation are said to be truly

intelligent machines, in that:-

Ambharic etc.

The summarized form for generation of computer

Learn from experience

Incorporate artificial intelligence

Can process natural language, like English,

Generation | Year Circuit element Z"dary storage Computer Operating Memory
device language system access time
First 1940-56 Vacuum tube Punched card Assembly & Operator 1millisecond
machine manual
control
Second 1957-63 Transistor Magnetic tape COBOL & 10 micro
FORTAN second
Batch
Third 1964-70 Integrated Interactive 100nano
circuits or time second
Magnetic disk Structured sharing
Fourth 1970- microprocessor Virtual 1nano second
nowaday
or VLSI Mass storage Application
oriented
Page 17 of Federal TVET Agency |Basic Agricultural Production and Natural version -1
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Types of Computers
A. Classification based on the method of operation
1. Analog computers

They operate by measuring
They deal with continuous variable

They are special purpose computers

D NN NN

They have limited accuracy

Examples, Thermometer, Voltmeter, Speedometer and Gasoline pomp.

2. Digital computers

v They deal with discrete variables
v They operate by counting rather than measuring
v

They have higher accuracy and speed than

analogue computers

Examples, abacus, desk and pocket calculators & general purpose computers

3. Hybrid computers

The best features of analog & digital computers can be combined into a single device to

form a hybrid computer.
B. Classification based on their purpose (application)
i. Special purpose computers
Are designed to solve a single type of problem (for a specific application or situation)

E.g. Traffic control system, public telephone box, ticket machines & pocket calculators

N.B. most analog computers are special purpose computers.
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ii. General purpose computers
They are more flexible & versatile

E.g. Micro, mini, main-frame &super computers

C. Classification based on their size, price, capacity & performance

i. Micro computers

o Known as personal or desk top computers
° [ts CPU is a microprocessor
o Microprocessor is a processor all of whose

components are on a single Integrated circuit chip, so that it can serve only one user at a
time (single user).

E.g. home & office computers

Microcomputers come in a variety of sizes and shapes. Basically they can be grouped into

three: Laptop, palmtop and desktop computers.
ii. Mini computers

o Have relatively lower speed than main frame
computers and can handle multi users (2-4 users at a time) and are used in small
organizations

o Minicomputers play a major role in computer-
aided design (CAD) and computer aided manufacture (CAM).

iii. Mainframe Computers

Smaller in size & capacity lower in speed & memory capacity than super computers. They are
multi-user systems (100 users at a time) and are used in large organizations.
iv. Super Computer

[s the fastest, most powerful, most expensive & largest computer.
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Perform hundreds of millions of operations per

They are multi-user systems (200 users at a

They can carry out enormously complex scientific

They are used in;-Space technology centers, meteorology stations, astronomical observations,

intercontinental communications and air line organizations.

Functionalities of a computer

Any digital computer carries out five functions in gross terms:

AR RN

Takes data as input

Generates the out put

Control all the above four steps

Processing

Stores the data/instruction in its memory and use them when required

Process the data and converts it in to usefull information

Data —— M + |nformation

Computer Components

Any kind of computers consists of HARDWARE and SOFTWARE: Computer hardware is

the collection of physical elements that constitutes a computer system.

v" Computer hardware: refers to the physical parts or components of a computer

such as the monitor, mouse, keyboard, computer data storage, hard drive disk
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(HDD), system unit (graphic cards, sound cards, memory, motherboard and chips),

etc. all of which are physical objects that can be touched.

Input Devices: Input device is any peripheral (piece of computer hardware equipment to

provide data and control signals to an information processing system such as a computer

or other information appliance. Input device Translate data from form that humans

understand to one that the computer can work with. Most common are keyboard and

mouse

Examples of Manual Input Devices

Kiyboard Numeric Keypad | Pomnting Device | Remaote Contral
Jovstick Touch Screen Scanner Ciraphics Tablet
Micraphone Drgital Camera Webcams Lipht Pens

i

Central Processing Unit (CPU): A CPU is brain of a computer. It is responsible for all

functions and processes. Regarding computing power, the CPU is the most important

element of a computer system. The CPU is comprised of three main parts:

e Arithmetic Logic Unit (ALU): Executes all arithmetic and logical operations. Arithmetic

calculations like as addition, subtraction, multiplication and division. Logical operation like

compare numbers, letters, or special characters
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¢ Control Unit (CU): controls and co-ordinates computer components such as

v

v
v
v
v

Read the code for the next instruction to be executed.

Increment the program counter so it points to the next instruction.

Read whatever data the instruction requires from cells in memory.

Provide the necessary data to an ALU or register.

If the instruction requires an ALU or specialized hardware to complete, instruct the

hardware to perform the requested operation.

e Registers: Stores the data that is to be executed next, "very fast storage area".

v Primary Memory:-

1. RAM: Random Access Memory (RAM) is a memory scheme within the computer
system responsible for storing data on a temporary basis, so that it can be promptly
accessed by the processor as and when needed. It is volatile in nature, which means that
data will be erased once supply to the storage device is turned off. RAM stores data
randomly and the processor accesses these data randomly from the RAM storage. RAM is
considered "random access" because you can access any memory cell directly if you know

the row and column that intersect at that cell.

2. ROM (Read Only Memory): ROM is a permanent form of storage. ROM stays active
regardless of whether power supply to it is turned on or off ROM devices do not allow
data stored on them to be modified. Secondary Memory:-Stores data and programs

permanently: its retained after the power is turned off

3. Hard drive (HD): A hard disk is part of a unit, often called a "disk drive," "hard drive,"
or "hard disk drive," that store and provides relatively quick access to large amounts of

data on an electromagnetically charged surface or set of surfaces.

4. Optical Disk: an optical disc drive (ODD) is a disk drive that uses laser light as part of
the process of reading or writing data to or from optical discs. Some drives can only read
from discs, but recent drives are commonly both readers and recorders, also called

burners or writers. Compact discs, DVDs, and Blu-ray discs are common types of optical

Page 22 of
125

Federal TVET Agency
Author/Copyright

Basic Agricultural Production and Natural

Resources Conservation Level-I

Version -1
October 2019




ey

4@32

k7
O%'i/rvgl@"‘d
media which can be read and recorded by such drives. Optical drive is the generic name;

drives are usually described as "CD" "DVD", or "Blu-ray"”, followed by "drive", "writer",

etc.

There are three main types of optical media: CD, DVD, and Blu-ray disc. CDs can store up
to 700 megabytes (MB) of data and DVDs can store up to 8.4 GB of data. Blu-ray discs,
which are the newest type of optical media, can store up to 50 GB of data. This storage
capacity is a clear advantage over the floppy disk storage media (a magnetic media),

which only has a capacity of 1.44 MB.

Flash Disk: A storage module made of flash memory chips. Flash disks have no
mechanical platters or access arms, but the term "disk" is used because the data are

accessed as if they were on a hard drive. The disk storage structure is emulated.

Companson between Main memocy (RAM) and Secondary Memory (Hard disk)
RAM Hard Disk (Hard Drive)
Memory Storage
Smaller amount Much larger amount
(t}]\](ﬂll)' SO0 MB-6 GB) IK_\]‘!L‘.\”‘,' SOGH to 1000 GB)
Temporary storage of files and programs Permanent storage of files and programs

A little like your real desktop - has only your
current work on 1t (which could be ruined by a
spill of Coke or coftee!)

Like a file cabinet - has long-term storage of
work (it's safe from spills?)

Contents remamn when you tumn off the power
Contents disappear when vou tumn off power to to the computer (thev don't

the computer and when the computer crashes disappear unless yvou purposely delete them)
and when the computer crashes
X Consists of hard disks (platters)
Consists of chips (microprocessors)

When vou want to use a program, a temporary Holds the onginal copy of the program
copy is put into RAM and that's the copy you use permanently

Output devices: an output device is any piece of computer hardware equipment used to
communicate the results of data processing carried out by an information processing
system (such as a computer) which converts the electronically generated information into

human-readable form.
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Computer Software

Software is a generic term for organized collections of computer data and instructions,
often broken into two major categories:

System software that provides the basic non-task-specific functions of the computer, and
application software which is used by users to accomplish specific tasks.

Software Types

A. System software: is responsible for controlling, integrating, and managing the
individual hardware components of a computer system so that other software and the
users of the system see it as a functional unit without having to be concerned with the low-
level details such as transferring data from memory to disk, or rendering text onto a
display. Generally, system software consists of an operating system and some fundamental
utilities such as disk formatters, file managers, display managers, text editors, user

authentication (login) and management tools, and networking and device control software.

B. Application software: is used to accomplish specific tasks other than just running the
computer system. Application software may consist of a single program, such as an image
viewer; a small collection of programs(often called a software package) that work closely
together to accomplish a task, such as a spreadsheet or text processing system; a larger
collection(often called a software suite) of related but independent programs and packages
that have a common user interface or shared data format, such as Microsoft Office, which

consists of closely integrated word processor, spreadsheet, database, etc.; or a software
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system, such as a database management system, which is a collection of fundamental

programs that may provide some service to a variety of other independent applications.

Comparison Application Software and System Software

Syztemn Software

Application Softwars

Computer soffocare, or just software iz a
general term primarily used for digitally stored
data such as computer program: and other
kinds of information read snd written by
computars. App comes under compater
softorare though it has a wide scope now.

Application zoftware, also kmown az an
application or an "spp", is computer software
dezigned to help the uzer to perform specific
tazks.

Exampla: . - ' 1} Opeara (Web Browser)
1:}" [EI'I.;:“R Windows 2} Microsoft Word {Word Droceszing)
;}Uni: 3} hicrosoft Excel (Spreadshest software)
4) Mac 05X 43 Mv3QL (Databaze Sofforars)
5)DOS 5} hMicrosoft PowerPoint {Presentation Software)
6} Adobe Photoshop (Graphics Software)
Interaction- o allv. mzers do mot interact with = Uszers always imteract with application software
softwars as it works in the backeround. ’ while doing different activities.
Dependency: Syztemn software can mn independently of the | Application sofioare cannot mn without the

application sofiware.

presence of the svstem softwara.

Unit of Measurements

Storage measurements: The basic unit used in computer data storage is called a bit (binary

digit). Computers use these little bits, which are composed of ones and zeros, to do things

and talk to other computers. All your files, for instance, are kept in the computer as binary

files and translated into words and pictures by the software (which is also ones and zeros).

This two number system is called a “binary number system” since it has only two numbers

in it. The decimal number system in contrast has ten unique digits, zero through nine

Computer Storage units

Size example

* 1 bit-answer to an yes/no question

* 1 byte -a number from 0 to 255.

Bit BIT forl
Kilobyte EBE 1024 btes
Megabyte MB 1024 knlobytes
Gigabyte GB 1024 mezabytes
Terabyte TE 1024 migabytes

* 90 bytes: enough to store a typical line of text from a book.
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* 4 KB: about one page of text.
* 120 KB: the text of a typical pocket book.
* 3 MB -a three minute song (128k bitrate)
* 650-900 MB -an CD-ROM
* 1 GB-114 minutes of uncompressed CD-quality audio at 1.4 Mbit/s

* 8-16 GB -size of a normal flash drive

Speed measurement: The speed of Central Processing Unit (CPU) is measured by Hertz(Hz),
Which represent a CPU cycle. The speed of CPU is known as computer Speed.

CPU SPEED MEASURES
1 hertz or Hz 1 cycle per second
1 MHz 1 million cycles per second or 1000 Hz
1 GHz 1 billion cycles per second or 1000 MHz

Computers classification

Computers can be generally classified by size and power as follows, though there is

considerable overlap:

Personal computer: A small, single-user computer based on a microprocessor. In addition
to the microprocessor, a personal computer has a keyboard for entering data, a monitor for

displaying information, and a storage device for saving data.

Workstation : A powerful, single-user computer. A workstation is like a personal

computer, but it has a more powerful microprocessor and a higher-quality monitor.

Minicomputer : A multi-user computer capable of supporting from 10 to hundreds of

users simultaneously.

Mainframe : A powerful multi-user computer capable of supporting many hundreds or

thousands of users simultaneously.
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Supercomputer : An extremely fast computer that can perform hundreds of millions of

&

instructions per second.

Laptop and Smartphone Computers LAPTOP: A laptop is a battery or AC-powered personal
computer that can be easily carried and used in a variety of locations. Many laptops are
designed to have all of the functionality of a desktop computer, which means they can
generally run the same software and open the same types of files. However, some laptops,

such as netbooks, sacrifice some functionality in order to be even more portable.

Netbook: A netbook is a type of laptop that is designed to be even more portable.Netbooks
are often cheaper than laptops or desktops. They are generally less powerful than other
types of computers,but they provide enough power for email and internet access, which is

where the name "netbook" comes from.

Mobile Device: A mobile device is basically any handheld computer. It is designed to be
extremely portable, often fitting in the palm of your hand or in your pocket.Some mobile
devices are more powerful, and they allow you to do many of the same things you can do
with a desktop or laptop computer. These include tablet computers, e-readers, and smart

phones.

Tablet Computers: Like laptops, tablet computers are designed to be portable. However,
they provide a very different computing experience. The most obvious difference is that
tablet computers don't have keyboards or touch pads. Instead, the entire screen is touch-
sensitive, allowing you to type on a virtual key board and use your finger as a mouse

pointer.

Tablet computers are mostly designed for consuming media, and they are optimized for
tasks like web browsing, watching videos, reading e-books,and playing games. For many

people, a "regular” computer like a desktop or laptop is still needed in order to use some
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programs. However, the convenience of a tablet computer means that it may be ideal as a

second computer.

Smart phones: A smart phone is a powerful mobile phone that is designed to run a variety
of applications in addition to phone service. They are basically small tablet computers, and
they can be used for web browsing, watching videos, reading e-books, playing games and

more.

Data, Information and Knowledge

Data: Facts and figures which relay something specific, but which are not organized in any
way and which provide no further information regarding patterns, context, etc. So data

means "unstructured facts and figures that have the least impact on the typical manager."

Information: For data to become information, it must be contextualized, categorized,
calculated and condensed. Information thus paints a bigger picture; it is data with
relevance and purpose. It may convey a trend in the environment, or perhaps indicate a
pattern of sales for a given period of time. Essentially information is found "in answers to

questions that begin with such words as who, what, where, when, and how many".

Knowledge: Knowledge is closely linked to doing and implies know-how and
understanding. The knowledge possessed by each individual is a product of his experience,

and encompasses the norms by which he evaluates new inputs from his surroundings.

Opening Your Computer

To start a Computer for the first use after checking the electric is connected to the source
or socket we follow the following simple steps:

Step 1: Press the start button on the CPU tower.
Step 2: Wait while the computer boots. When the computer has finished booting, it will

show a dialogue box that will ask for a user name and password.
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Step 3: Enter your user name and password, and then click "OK."

Step 4: Your computer is now ready to use.

2.1 Whatis Windows?

A window is the rectangular portion of a desktop that displays an open program or the
contents of a folder or disk. You can open multiple windows at a time. This ability (opening
more than one program at a time.) is one of the distinguishing features of windows. Windows
is a single user, multitasking operating system. Unlike DOS, the Windows operating system
provides a graphical user interface.

The latest version of windows is Windows XP (last XP) and windows vista. Earlier versions
were Windows 2000, Windows 98, etc. In this training manual, we shall see how to use
Windows XP.

Benefits of Windows
The main benefits of MS-Windows over that of MS-DOS are:

¢ No need of memorizing commands and switches.

* No typing required. You simply click on menus, dialog boxes, option buttons, list
boxes, etc.

¢ The availability of many programs designed to run under windows.

¢ The possibility of sharing information between windows program is high.

¢ High support for communication.

% Use of many programs simultaneously.

% High support for long file name, enabling file organization easier.
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Self-Check -1 Written Test

Name: Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid
some explanations/answers.

1. whatis window ?
2. differentiate data,information and knowledge
3. explain briefly about the following parts of a computer

a. Hardware b. software

Note: Satisfactory rating - 10 points and above Unsatisfactory - below 10 points

You can ask your teacher for the copy of the correct answers.

Answer sheet
Score =
Rating:
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Operation sheet

Opening/logging a computer

Objectives:

o To understand how to open a computer for the first time

Procedures to follow

To start a Computer for the first use:

Step 1: check the electric is connected to the source or socket

Step 2: Press the start button on the CPU tower.

Step 3: Wait while the computer boots. When the computer has finished booting, it will

show a dialogue box that will ask for a user name and password.

Step 4: Enter your user name and password, and then click "OK."

Step 5: Your computer is now ready to use.
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Information Sheet-4 | Identifying basic functions and features

4.1 Using a mouse and a keyboard

Keyboard is an input device used to enter information into your PC. There are
essentially dozen keyboard designs. The keys on the keyboard can be divided into 5
sections.

Alphanumeric (Character Keys): These keys work just like a conventional type writer
which consists of letters (A-Z), numbers (0-9), Enter key, Spacebar, Backspace, Shift,
Caps lock, etc.

Function Keys: These keys perform different tasks based on the type of application

you are working on. Function keys are labeled as F1, F2... F12.

Numeric Keys: Let you enter numerical data more easily when you are working on

numbers. To use this section of the keyboard, make sure that the Num Lock key is ON.

Navigation (Cursor movement Keys): These keys are used to navigate through your

document. The keys are: Arrow keys, Home, End, Page up, Page down, etc.

Computer (Special) keys: They perform different tasks when used alone or in
conjunction with other keys. Some of these keys are: Alt, Ctrl, Print Screen, Scroll Lock,

Pause, Delete, and Insert

Mouse

A mouse is a pointing device that is used in windows. It is a hand held device that
controls the movement of a pointer on your screen. The object that moves around the
screen as the mouse is moved is called a mouse pointer.

There are usually two buttons on the mouse: Left and Right button.
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The terms used while using mouse are:

Pointing: Positioning the mouse cursor over an item or an area you want.
Clicking: Positioning and pressing the left mouse button once.

Double Clicking: Clicking the mouse button twice quickly over an object.
Dragging: Positioning the mouse cursor on an object, holding the mouse button
down and moving the cursor to a desired place before releasing the button.
Remark: the shape of the mouse cursor changes to signify or indicate different
things. These are:

AN NANIN

¢ Vertical resize: To resize top or bottom boundary of window or an object.

> Horizontal resize: To resize the left or fight boundary of window or an object.

“ &7

I»

3

124

—

Diagonal resize: To resize the diagonal corners of a window or an object.

Move: Whenever you have selected on object for moving, your pointer would turn into
this shape.

Normal Select: Whenever you normally point the mouse pointer at any object or icon,
scroll bar, or menu the mouse pointer would turn into this shape.

Help Select: Whenever you click on what is this? Form the help menu or press shift +
F1 on the key board, the mouse pointer would turn in to this shape. Once you get this
shape, simply click on the icon for which you want description.

Working in back ground: Whenever you execute a command, which takes, a couple,
windows would display this shape. This means that the window is processing your
request in the background.

Busy: When ever windows is trying to load some information in to the computer
memory, or is busy trying to open or save a file, this mouse pointer would be displayed.
Text select: Whenever and wherever you can work on some text or some typed input is

required from the user, this mouse pointer would be displayed.
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Self-Check -1 Written Test

Name: Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid
some explanations/answers.

1. Whatis key board ?

2. Explain the functions of the following key board sections
a) Navigation (Cursor movement Keys

b) Function Keys
c) Numeric Keys
3. What is mouse and explain the function of mouse

Note: Satisfactory rating - 10 points and above Unsatisfactory - below 10 points

You can ask your teacher for the copy of the correct answers.  Answer sheet| Score =

Rating:
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Information Sheet-5 | Customizing desktop configurations.

Desktop

When you start Windows XP, the large area you see is called the Desktop, on which icons,
windows and applications are displayed. Think of the Desktop as your personal
workspace.

Changing the Desktop's Pattern or Wall Paper
Display: Is used to modify Desktop background, Screen savers, Menu appearances etc.
Background: Desktop wallpapers decorate and add more colors fun to your life.

» To change background:
Right click on desktop—>Properties—> Desktop/background-> Select one - 0k/Apply

Screen Saver: [s a moving image or pattern that appears on your monitor when you have
left your computer idle for specified limits.

» To change the Screen Saver:

Right click on desktop—>Properties=>Screensaver—>Select one - 0k/Apply Or

> Right click on desktop—>Properties—=> Screensaver—>Select marquee = settings>write
the text you want and format - Change the waiting period—> Ok/Apply
Arranging the Icons on the Desktop

You can arrange icons on the Desktop by simply dragging and placing them where you
want to place them.

1. Rightclick = Arrange icons => Click on the desired type of arrangement
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Self-Check -1

Written Test

Name:

Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid

4. What is desktop?

some explanations/answers.

5. How we can change the arrangement of desktop icons?

Note: Satisfactory rating - 10 points and above

You can ask your teacher for the copy of the correct answers.

Answer sheet

Unsatisfactory - below 10 points

Score =

Rating:
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Operation sheet Change desktop background

Objectives:

o To understand how to change desktop backgrounds

Procedures to follow
To change the background of a desktop the following steps are used.
Step 1:Right click on desktop
Step 2:select properties
Step 3: click Desktop/background
Step 4: Select one

Step 5: click Ok/Apply

Information Sheet-6 | Using help functions

Using Help
If you do not know how to do something, you can look it up in help.

» To use help:
Click the Start button—-> Help—>Type document you want the help—> Find

Getting Help in a Dialog box

You can get Help on each item in a dialog box by clicking the question mark button in the
title bar and them clicking the item. If the dialog box doses not have the button, look for a
Help button, or try pressing F1.

Another way to get help is to use your mouse button to click an item, and then click what is
this? On the menu that appears.
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Name: Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid

1. Why we use help function ?

some explanations/answers.

2. How can we use help function ?

Note: Satisfactory rating - 10 points and above

You can ask your teacher for the copy of the correct answers.

Unsatisfactory - below 10 points

Answer sheet

Score =

Rating:
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Instruction sheet

Learning Guide #70

This learning guide is developed to provide you the necessary information regarding the
following content coverage and topics:

¢ Opening closing and accessing desktop icons

¢ Opening, resizing and closing desktop windows

e Creating shortcuts

This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon completion of this Learning Guide, you will be able to:-

e Start computer, system information and features

e Navigate and manipulate desktop environment

e Organize files using basic directory and folder structures

e Print information

. Shutdown computer
Learning Instructions:

A N .

Read the specific objectives of this Learning Guide.

Follow the instructions described

Read the information written in the information “Sheet

Accomplish each “Self-check respectively.

If you earned a satisfactory evaluation from the “Self-check” proceed to the next or

“Operation Sheet
Do the “LAP test”
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Information Sheet-1 | gpening closing and accessing desktop icons

The Windows desktop contains a range of icons, some of which appear when you install
Windows, and some that appear when you install new programs. Icons with an arrow are
known as shortcuts or links to programs, files or folders. You can double-click on a desktop
icon to launch that program, folder or file. Below are some common desktop icons.

Iconms

&

o A )

What They Represent

Programs

The icons to the left represent shortcuts to various programs.
You can tell it's a shortcut as it contains an arrow. So, if you were
to delete the shortcut, you wouldn't be deleting the actual proegram.
only the desktop link to it.

Double-dicking on the relewvant icon will launch that program. For
example, if you double-click on the icons to the left you will launch:

1. Microsoft Word 2007 (word processing program )
2. Mozilla Firefox {internet browser)

3. Adobe Reader 9 (to view PDF files)

Files

Icons that show a page represent a fife. When you double-click on
the icon, the file will open in the program that it was created in. The
picture to the left shows that the file was created in Notepad.
However, as no arrow appears, it is not a shortout, but indicates
that this file was actually saved to the desktop. Therefore, if this
desktop icon is deleted, =o is the actual file.

Folders and drives

Icons that show a folder represent a folder or shortcut to a folder.
When you double-dick en a felder icon, the Windows Explorer
wiindow will open and you will see the contents of that folder.
Similarly, icons that show a hard disk will display the contents of
that drive in Windows Explorer when you double-dick on it.
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Self-Check -1 Written Test

Name: Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid
some explanations/answers.

1. Mention at list three desktop icons and explain how to open them.

Note: Satisfactory rating - 10 points and above Unsatisfactory - below 10 points

You can ask your teacher for the copy of the correct answers.

Answer sheet
Score =
Rating:
Information Sheet- | gpening, resizing and closing desktop windows

When a new icon appears on the desktop, it usually sits along the left side of the screen.
However, just as you can arrange items on your desk to suit your preferences, you can also
arrange icons on the desktop to sit wherever you'’d like. As well as arranging icons, you can
also resize them, that is, make the icons larger or smaller.

Try This Yourself: 9 ,

Before starting this exercise ensure . o P
you are viewing the desktop...

wd xw
1 Click and hold down the left mouse
button on 2 desktop icon, and drag to
another part of the desktop, then
release the mouse button

sf3imir)y v
hanw e
5 Geexlbn e cars '
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L
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Cocqmx

The icon returns to its original
position, as the auto-arrange option is
tumed on...

Right-click on a blank area of the
desktop to display a shortcut menu

Select View > Auto arrange icons
to turn this option off

Select View > Align to grid to tum
this option off

“ & W N

Repeat step 1

You can now freely move your icons



The Start button and Taskbar

The taskbar is located at the bottom of your screen. It is a bar and contains the Start
button (allows you to quickly start a program or to find a file), Tool bar, Clock and other
features. At the far-right corner of the task bar, you see the system clock. Point your
cursor (double click on it) to see the date and time. When you open a program,
document or window, a button appears on the taskbar. You can use this button to
quickly switch between the windows you have opened by clicking its taskbar button.
When you click the start button, you see a menu that contains everything you need to

begin windows

Date and Time

Inside your computer, there is a component called a real time clock (RTC). This RTC and
COMS battery ensure that the basic settings are lost when you switch off your computer.
RTC stores the current time and date in your computer and passes on this information to
put a date and time to correct operations.

Time Zone: This option determines which time zone you are in. Especially for Laptop

users who zip across many countries (and time zone frequently).

» To change the time zone to adjust your system clock:

Double click on taskbar at desktop—=>you can adjust the time, date, time zone—>0k/Apply

2.5 Elements of opened windows
Most windows have certain elements in common which looks like as the fig. Below.

Control Menu: When clicked on, this box drops a system menu. The menu contains the
Move, Resize, Maximize, Minimize, Restore and Close buttons. It is also called the system

icon.
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Title Bar: Contains the name of application, program or currently opened document. It is
used to move a window by holding down the left mouse button and move it to the desired
place. It is also used to maximize or restore a window (double click on it).

Menu bar: is an area with a series of menu names. Clicking in this menu name drops a
menu that contains a number of commands from which we can select.

Minimize, Maximize and Close Buttons: They are located in the top, right-hand corner of
ever window. When you click on the minimize button, the window is reduced to an icon on
the taskbar. The Maximize Button is changed to Restore button, which returns the window
to its original state.

Scrolling Arrows and Bars: Very often, a window you open can't display everything that is
in it. If so, the window will have a scrolling arrow and bar, either a vertical one along the
right side or a horizontal one across the bottom, or both. If a window doesn't have anything
hidden that you can't see, you will not see any scroll bars. To see more of what a window
has, click on the scroll arrow and hold the mouse button down, or drag the scroll bars to
scroll more swiftly.

Standard Toolbar Minimize

Formatting toolbar Title bar Button

Menu bar

Times News Foman - 12 - Szt " B S 1O A@ = MaXImlze
“- Button
s, Elements of winndows Close
| button

Iflost windows have certain elements it commnon which looks like as the fig. Belowar.

Control Ivlenu: “Ahen clicked on, this box drops a swstetn mmenu. The menu contains the Wowve,

Vertical

Title Bar: Contains the name of application, program or currently opened document. Tt is used t\ Scroll bar
DMenu bar: 15 an area with a senes of menu names. Cholung i this menu name drops a menu tha
X
fjr Help, press F1 NUI#
¥
Status bar
Down
Lef )
I Right Scroll Arrow Scroll
SCro . . .
3 of Federal TVET Agency |Basic Agricultural Production and Natural Arrow
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Fig 2.1

There is also a status bar at the bottom if the window that gives you information about
what is in windows, If you are not viewing the status bar choose status bar from view
menu. The status bar has hider features that show you what menus will do if you choose an
option from them and displays in information explaining what the mysterious icons are as

you move the mouse pointer over them.

2.6 Starting and Quitting Programs
Starting a Program

% To start a Program:
1. Click the Start button, and then point to All Programs

2. If the program you want is not on the menu, point on the folder that
contains the program.
3. Double-click the program.
Remark: If the program you want to start doesn't appear on the All Programs menu or one
of its submenus, point to Search on the start menu and then click Files and Folders. Use the
Search dialog box to type the program you want and click Search. From the search results

dialog box, double click the program you want to open.

Alternative Method: Starting a program by using the Run command.

1. Click the Start button, and then click Run.

2. Inthe Open box, type the location and name of the program you want to start. If
you don't remember the location or name of the program file, click Browse and
from the programs that appear, double-click on the program you want to open.

Starting the Word Pad
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Windows includes a text editor, Word pad, which you can use to create and modify
documents.

» To start Word pad:
Start button—> All Programs—> Accessories=> Word pad

Starting Paint
Windows includes a program, paint that enables you to create, modify or view pictures.

» To start Paint:
Start button—> All Programs—> Accessories—> Paint

Starting Calculator

Windows includes a program, called Calculator that enables you to perform simple
calculations. You can use Calculator in Standard View to do simple calculations or use it in

Scientific View to do advanced scientific and statistical calculations.

» To start Calculator:
Start button—> All Programs—> Accessories—> Calculator

Switching between Windows

You can switch to another opened programs or a window by clicking its button on the
Taskbar or click on anywhere inside the window (if not minimizes). Switching doesn't

close the program window you were working in; it just changes the view on your screen.

Cascading and Tiling Windows

Cascading means arranging windows one over the other, while Tiling means arranging
windows side by side. Use the right mouse button to click on the empty space of Taskbar
and then click Cascade Windows (arrange windows on over the other) and Tile Windows
horizontally or vertically (To arrange windows side by side) from the pop-op menu, as

you want.

2.7 Menu Conventions
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Commands or sometimes characteristics are listed on menus. Most applications have their

own menus, which are listed on the menu bar along the top of the application window. To
choose commands from a menu, click on the menu, move the mouse pointer on the menu

item and click on the item you want.

The following menu conventions are used in windows

a) A Check Mark (v) to the left of a command: shows the command is in effect at the
Current time.

b) A Triangle ( ) to the right of a command: shows you that if that command is
chosen, another files or folders are placed.

c) Dimmed or not visible menu: The command cannot be used at the current

condition.
d) A key combination to the right of a command: shows the shortcut for the chosen

command by suing the keyboard.
e) An ellipse (...) following a command: A dialog box appears when the command is

chosen.

An ellinse Kev combination

O Document?2 - Microsoft Word

Eile Edit R = Insert Format Tools Talple W imdone Helg
L1 e IR e e
1 s
: y Open... Cirl+O I |-§ = =
= Close [
[ - R - B |
=l | Save Ciri+s A Triangle
Save as.Y
4Ly Sawve as \Web Page...
21 File Search... )
| Permission -V | Unrestricted Aaccess
wWarsions... Do Distribute. ..
web Fage Preview ResTict wﬁ .
Fage S
: ) . A Check Mark
2 Print Preview Dimmed or not
—
visible

Dialog Boxes

Dialog boxes are specialized windows, which appears when you need to supply additional

information to complete a task. The elements of dialog boxes are:
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Combo Boxes (Drop-Down List Boxes): provides features of a text box and list box

S

-~

because you can type right into it or select from a list of choices. To choose an item in
combo box, click on the down arrow, and from the choices that appear click on your

choices.
Text Boxes: Boxes in which information is typed against on insertion point.

Check Boxes: Are used to set ON or OFF. You can check more then one check box in a

group.

Option Buttons: Option button are some times referred as radio buttons. Only one option

button in a group can be selected. Click on the one you want to choose it.

Command and buttons: Buttons to choose a command to initiate and action. The action
the button will perform will indicate on the button itself. The action can either be indicated
by graphics as on a toolbar or by text as on the OK, Cancel, Quit Open and Help button

found in many dialog boxes.

Combo

List
J B Check
) (0).4
= T B
£ a Box
Regular
-~ a ~
Italic 9
Bold 10
Bold Italic 11
et R
Underline skyvle:
| | {none) -
Effects
[ strikethrough Shadow TeXt BOX
[1 Double strikethrough [1 cutline i
Superscripk [] Emboss [] Hidden
[1 subscript [1 Enarave
Lab stop position: o tab stops:
Presiew S -
TIMES MEW FOMAN
Option
This is a TrueTwpe fonk, This font will be used on both printer and screen, < 3
Defat.. - ——— button
—T—

Tabs: Some dialog boxes have multiple sections and categories. Tabs separate such section
and only the option on currently highlighted tab can be viewed. When you select different
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tabs, the original tab move back and the new tab is brought in to foreground. To move
between different tabs in a dialog box, click on the tab required.

Quitting an Opened Program

» To close a program:
1) Click on the Close (X) button from the top-right corner of the window,
or
2) File > Exit
3) From keyboard press Alt+F4
If you are using multiple windows, and want to close all opened windows, hold the Shift

key and then click the Close (X) button in the upper right corner of the title bar.

Self-Check -1 Written Test

Name: Date:

Directions: Answer all the questions listed below. [llustrations may be necessary to aid
some explanations/answers.

1. Differentiate between cascading and tilling windows.
2. Select one program and explain the steps to open that program.
3. What are the common elements of an opened window? Mention at list
four elements
Note: Satisfactory rating - 10 points and above Unsatisfactory - below 10 points

You can ask your teacher for the copy of the correct answers.

Answer sheet
Score =
Rating:
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Opening a program

Objectives:

o Understand how to open a program you want to work in
o To locate the directory in which the program is located

Procedures to follow

» To start Word pad:
Step 1: Click Start button on the bottom left corner of the computer

Step 2: Click All Programs

Step 3:Click Accessories

Step 4: Finally double click Word pad
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Information Sheet-1 | creating shortcuts

Desktop icons are designed to enable quick access to frequently-used programs, files,
folders and so on. Many of these icons will be shortcuts, which are used to launch a
program (or whatever) from another location. You can create desktop shortcuts for pretty
much anything on your computer: programs, files, folders, windows and the like

Try This Yourself: E

Before starting this exercise
ernsure you are visewing che Seunt: e oy | fom o Crmmte s sfosfont
desktop._ .. .
Right-click on a blank area of e

the desktop to display a e

shortocut Mmsnu —_
Select New > Shortcwut to R

display the Create Shortcuwt
dialog box

Click on [Browse] to display
the Browse for fles and folders
dialog box

Click on the white arrows [+
beside Libraries and then ﬂ . ] |
Documents, and then dick
on My Documents to select

a W ON -

Smnct T terpee o ow Tt o

it — -
o Click om [OK] and then click L L

on [Mext] “ I Secunass

You will then be asked to o el

namre the shortocwt but vouw
will keep it s My

Do mrents. . E =
o Click on [Fimish] B Pl
The My Documents folder tle i =
now appears s & shortcut on - ———— — F—
yvour deskiop. ..
Double-click on the My
7 Documents shortowre o E [ =
launch Windows Explforer L. =
and display the contents of A -
the My Docunrrents folder iy
_ QLTS L]
2 Click on cfose to clos=
Windows Explforer
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Self-Check -1

Written Test

Name:

Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid

Note: Satisfactory rating - 10 points and above

some explanations/answers.

1. How can you create a shortcut in desktop window?

2. What is the important of creating shortcut ?

You can ask your teacher for the copy of the correct answers.

Answer sheet

Unsatisfactory - below 10 points

Score =

Rating:
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Instruction sheet

Learning Guide #71

This learning guide is developed to provide you the necessary information regarding the
following content coverage and topics:

Creating folders/subfolders

Saving files

Renaming and moving fodders/subfodders

Identifying folders/subfolders and file attributes

Moving folders/subfolders and files

Saving folders/subfolders and files in appropiriate media.

Searching folders/subfolders and files

Restoring deleted folder/sub folder and files

This guide will also assist you to attain the learning outcome stated in the cover page.

Specifically, upon completion of this Learning Guide, you will be able to:-

e Start computer, system information and features

e Navigate and manipulate desktop environment

e Organize files using basic directory and folder structures

e Print information

. Shutdown computer
Learning Instructions:

A N

Sheet

Follow the instructions described

6. Do the “LAP test”

Read the specific objectives of this Learning Guide.

Read the information written in the information “Sheet

Accomplish each “Self-check respectively.

If you earned a satisfactory evaluation from the “Self-check” proceed to the next or “Operation
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Information Sheet-1 | Creating folders/subfolders

1.2 Working with Folders

In widow, you store your work in folders just like you would in your office or at home.

Both the Explorer and My computer objects allow you to look at your programs, files and
folders stored on disk.

The Explorer: Allow you to see the hierarchy of all folders on your computer. Windows
explorer displays folders in the left hand-panda and the contents of the folder in the right
hand-pane.
» To open explorer and look at the hierarchy of folders:
1. Right click on the Start button and click Explore from the pop-up menu.
2. Click a folder on the left side of the window to display its contents on the
right. Click the plus (+) sign to display more folders.

Creating a New Folder
Your documents and programs are stored in folders, which you can see in My Computer

and Windows Explorer.

» To create a new folder Right click on desktop =>New—>Folder
» To change the name of a file or folder(Rename):

Right click on the folder>Rename

» To open a file or folder:

Double click on the Folder or file Or Right click on the file or folder 2 open.

» To select the Whole files or folders:
1. Click the first icon.
2. Hold down the Shift key while you click the last icon to be selected.

» To select only some files or folders:
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Hold down the CTRL key while clicking each one.

Self-Check -1

Written Test

Name:

Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid

some explanations/answers.

1. How can you store the files you created?

2.

Note: Satisfactory rating - 10 points and above

Allow you to see the hierarchy of all folders on your computer.

You can ask your teacher for the copy of the correct answers.

Answer sheet

Unsatisfactory - below 10 points

Score =

Rating:
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Operation sheet

Create new folder

Objectives:

o Understand how to create a new folder
Procedures to follow

> To create a new folder

Step 2: point to New

Step 3: select/click Folder

Step 1: Right click on the empty space on desktop
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Information Sheet-1

Saving files

1.1 Creating File

MS-Word

Word processing is computer program or application software that enables computer users

to create, edit, format, print and save documents or textual files for future retrieval and

revision.

The main advantage of word processing over typewriter in preparing documents is that

word processing enables you to make changes to already written documents.

Starting Word

To start Ms-Word

> click start button =B S e=ax |

% Windaws Update

» Point to all programs

> Point to Microsoft office
> Click Microsoft Word

Screen elements
The following are main screen elements of the word window

Title bar, Menu bar, Toolbars, Ruler, Typing area, View buttons, Browse buttons & Status

bar

e Title Bar
e Menu Bar

e Standard Toolbar

-Indicates application and current document in use
-General headings for accessing commands

-Quick access to basic features of Word

¢ Formatting Toolbar-Quick access to change the look of text

e Ruler -Indicates Margin, Tab and Indentation settings.
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-Can also be used to change these settings.

€ Scroll Bars -Allows quick movement around document
4 Status Bar -Shows position of Insertion Point and document status
Title Bar
4/// =12l x|
Menu Bar Ele” Edit  wiew  Insert  Format lool? Table Window Help Type & question for help (=] 5
Standard DSt s D80 - b
Toolbar <4 Mormal - Times Mew Roman - 12 v/]][_ﬂ»% = -
El R T T 4 % MNew Document > X
_/— : : : Open a document
Formatting word %P Back 1
TOOI bar Access ¥P Book 1

Ward 97 day 1
Access 97 Day 3
= More documents. ..

P New

Ruler — document
D — @ Choose docurnent. ..
Ocument are‘lm New from template
N [ ] General Templates., ..
N %I Templates on my Wweb Si SCrO” Bars

W ] Templak icrosoft. com

=
+ [ Add Metwark Place. ..
@ @ Microsoft word Help
v [w] Show at startup

Views : 2 = [0 /
Vs l=afsls o |

»
Draw~ [3 | Autoshapes~ > w ] O E 4l 2 B8 DL A== 5 il .

M ln1  col1 REC TRK EXT OWR
Status Bar iﬁStart”J ] & =3 |J #]untitled - Paint |[@Ipocument1 - Micrasof... Grnt=S2,  z2mzem
Typing text in word

When you are typing your text:

1. Do not press Enter to start new lines within a paragraph. Word wraps the lines for you.
Press Enter to end short lines of text, to create blank lines, and to end paragraphs. Each
time you press Enter, you insert a paragraph mark (I) into your document.

2. Press the Tab key to indent the first line of a paragraph.
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3. To type the same key repeatedly, hold the key down Word automatically converts some

repeated characters into different types of lines. For example, if your type three or more
asterisks (*) and press Enter, Word replaces them with a dotted line. Use the equal sign
(=) for a double line, the tilde( ) for a wavy line, the pound (#) symbol for a thick
decorative line, the hyphen (-) for a thin single line, or the underscore (_) for a thick
single line.

. To produce all uppercase letters without having to hold down the Shift key, press the
Caps Lock key once and then type. Press the Caps lock key-again when you’re ready to
switch off this feature.

. Click on the Show/Hide button in the Standard toolbar to see where you pressed the
spacebar, Tab, and Enter keys. A dot(.) represents a space, an arrow(=») represents a
tab, and a paragraph mark(I) indicates where you pressed Enter. You can use the
show/Hide button to check whether you accidentally typed an extra space between two
words (you’'d see two dots instead of one, for instance) or to see how many blank lines
you have between paragraphs. To turn Show/Hide off, just click on it again.

. If you accidentally type the wrong character, press the Backspace key ( with the left-
pointing arrow above the Enter key) to delete it. Do the same if you accidentally press

Enter, Tab, or the spacebar).

2.2 Saving afile

After text has been entered, if it is to be used again it needs to be saved.

There are two ways to save a document; Save As and Save.

To save a newly created document

# Select the File menu and choose the Save As... Command. Or click on the Save

button

4 The Save As dialog box will then appear on the screen, in front of the current

document.
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savens e
Save in: I[j ‘Wword CIA Course Notes j &= - [ D = Tools ~

tword 3P Book 1
o word %P Book 2

Word ¥P Book 3
Word #P Book 4

Favorites

=
= File pame: || = Save I
My Mebwork

Places Save as bype: IWUrd Document LI Cancel l

Options are given on:
what File Name will be given to the document

Where to save the document, i.e. which Drive and Folder.

 Enter the name of the file in the File name box.

# In the Save in area select the correct drive and folder.

# Click Save 23ve I

To update an existing document
€ Select File | Save

or. click on the Save button

Closing a Documents

€ Click File menu | Close command. /exit

€ If the document has not been previously saved, or if it has been updated, Word

displays a Message Box

Microsoft Word ==

& Do wou wank to save the changes to "wWword XF Book, 17

Mo I _ancel I

4 Three options are given:
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Yes displays the Save As dialog box if the document has just

been created or automatically saves the document if it is

being modified.
No clears the document from the active window.
Cancel returns to the document.

Starting a new document & opening a document from a disk

== P neyr e A B e wie

Creating a New Document Coen a docwnent

e cd = Fooacaobks 1
EeN el el o e il =L =T ="] B §

A new document can be opened at any o 2 dae 1

A== AT = S
I rMlorse o docoarmeseserike=. . .

time within Word: e
| | El=rmilk Coaaocoammie==rk
€ Select File | New. Or click on the ] Slank wweb Paas
e | El=armbk E—-rmr=Sil Ml =a =g
w=nmr Frasrws =3 cisLinrn ==l =W onl-Jn
New bUtton D ~ ﬁl i == C'C.I:l:uzel_lt. oo -

ey Fraoeress Eersagell et

Seraaeral TemmElat=e=. 0.

4 The New dialog box will appear on

T e=miEmlabte= oo FFlicroao=oFEt . oorm

the screen.

Temiplabte=s o Mm-S el Sibe=. 0.

i d Fde=kvroark Flac=. ..
FAAicro=oaFkt =S oarrcd FHe e
hhouva =3k =sE=SrEoaps

» Double Click Blank Document,

adl WRE

from the dialogue box

Opening an Existing Document

Once a document has been created, it can be opened at any time.

4 To open an existing document, select the File | Open command. Or Press the Open

|
button = on the Standard Toolbar. This will display the Open dialog box.
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7 | eefrd ®P Book 1
o) word %P Book 1
History word P Book 2
word P Book 3
o wword ®P Book 4
My Documents
(]
Deskiop
=]
Favorites
s I ]
], ”
— File nane: - open -
My Metwmork | =P
Flaces Files of trpe: Al word Docurments -1 Cancel I

# Click on the Look In: box and from the drop down list, select the drive and folder

from which to open the document.

Py

Look in:
History:

o,

Documenks

Fray

[ word CIA Course Motes

B‘j_ My Compuker

@ S Floppy (4
== Local Disk {Z:)
,ﬁ:‘ YolumeLabel (D)
B My Metwork Places
" My Documenks
[ word €18 Course Motes

£ FTP Locations
W= Add/Modify FTP Locations

€ Finally, click on the name of the file to be opened. It will appear highlighted.

€ Click on the Open button to open the file. Double clicking the file name also opens

the file.

Cursor Movement

The cursor keys can be used to move the cursor character by character and line by line.

Some of the more useful movement keys are as follows:

Description

Beginning of a line

End of aline

Beginning of a document

End of a document

Up one window

Key Press

<Home>

<End>

<Ctrl Home>

<Ctrl End>

<Page Up>
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Down one window o <Page Down>
Beginning of the next paragraph <Ctrl+ >V

Up one paragraph <Ctrl + 4 >

Next word <Ctrl +—>
Previous word <Ctr]l +«—>

Up one page <Ctrl +Page Up>
Down one page <Ctrl + Page Down>

Opening a Document from a Disk

To open a document:

1. Click on the Open button in the Standard toolbar (or choose File, Open).
The open dialog box will be displayed.

2. Click the disk drive containing the document.

All of the folders and files in the drive you clicked on are displayed in the dialog box.

3. Click the document you want to open, and double-click on it.

Alternative methods

v" Double click on my computer

Double Click the disk drive containing the document

Editing and formatting a text
Editing

Inserting and Deleting Text
Deleting Text
4 To erase a mistake position the cursor to the right of the mistake and use the
<Backspace> key (a left arrow or Del or BkSp with a left arrow). The <Del> or

<Delete> key can be used to delete a character to the right of the cursor.
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Inserting Text
4 To insert text, position the cursor where the text is required. Type in the text. New
characters are inserted to the left of the cursor.
Remember

4 Both the mouse and the cursor keys can be used to move the insertion point.

Selecting Words and Sentences
Most features of Word work on the basis that text is first selected and an action is then
performed upon the selected text.
4 Select text.
To select a word move the I-beam pointer /cursor over the word and
double click using the mouse.
To select a sentence hold down the <Ctrl> button and click once anywhere
within the sentence.
4 To remove the highlighting, click once with the mouse anywhere within the active

document or press one of the arrow keys.

Selecting Lines & Paragraphs
A line positions the mouse next to the line and click once
when the cursor changes to =1
A paragraph position the mouse next to the paragraph to be selected
then double click (treble clicking in the paragraph also
makes the selection).
An entire document position the mouse in the selection bar then treble
click.
Dragging the mouse in the selection bar will select text one line at a time.
To select small areas of text:

*

+¢ Click once with the mouse at the start of the desired text.
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% Drag to the end of the desired text by moving the mouse whilst keeping the left mouse
button pressed down.

®,

+» Release the mouse button to end text selection.

Undo and Redo

The Undo command allows the reversal of some of the last actions performed and Redo

allows reversal of the Undo.

¢ To correct a mistake by reversing an action, select the Edit menu immediately after the
action has been carried out.

¢ From the Edit menu select Undo (this is the uppermost command - the exact name of
the command will depend on the last action performed).

% After using Undo, selecting Edit | Redo..... will Redo that particular cancelled feature.

Select the Undo or Redo button on the Standard Toolbar Kl B .

Cut, Copy and Paste
The Cut, Copy and Paste commands are found within the Edit menu. This group of
commands allows text to be moved around a document, from one place to another, quickly
and easily.
Cutting or Copying:
% Select the area of text to be cut.
% Choose the Edit | Cut command. The selected text is removed from the active
document and is placed in a temporary storage area known as the clipboard.
The Copy command works in the same way, except that the original text remains in
the active document.
Text contained within the clipboard is available for use in most Windows-based
products. Text remains in the clipboard until it is either deleted from there or it is

replaced by further text being cut or copied to the clipboard.

Pasting:
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Move the insertion point to the position where the contents of the clipboard are to

X/
°e

appear and select the Edit | Paste command. The text that was cut or copied will appear
at the current insertion point. Note that the contents of the clipboard will remain

unchanged - the text can be pasted many times.
& B @R

Quick key press: Cut <Ctrl X>, Copy <Ctrl C>, Paste <Ctrl V>.

Cut, Copy and Paste buttons are on the toolbar.

Editing Text:

Changing Case

There are three character cases available within Word: uppercase,
21|

" Sentence case.

lowercase and sentence case (the first letter in the sentence being

in uppercase).

" Title Case

s To change the case of a group of characters, first select the ¢ togaecas

Ok I Cancel

characters.

¢ Select Format | Change Case... to open the Change Case dialog box.

The selected text can then be changed to any of the five options:
Sentence case has the first letter of the sentence in upper case.
Lowercase has all the words in small case.
Uppercase has all the words capitalized.
Title Case has all words beginning with an upper case letter.
tOGGLE cASE changes upper case to lower and vice versa.

«» If text is entered and the Caps Lock key has been left on, Word can automatically correct
the case of the text (e.g. capital to Capital) and turn the Caps Lock off. Carry on typing in
the text and when either <Spacebar> or <Enter> is pressed Word will automatically
correct the mistake. N.B. This is dependent on the correct selection being made within

Tools | AutoCorrect.

To change the case of a single word, position the cursor within the word.
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Quick key press <Shift F3>. Pressing <Shift F3> will change the case of the text.
Pressing <Shift F3> a second time will change the case once more. Further presses of
<Shift F3> continues to change the case following the cycle lowercase, sentence case,

uppercase, lowercase, etc.

Move/Copy Text (Drag and Drop)

The Drag and Drop facility within Word speeds up the process of moving text from one
location to another within a document.

¢ Select the text to be moved and position the pointer over the selected text so that the

pointer should appear as an arrow rather than the [-beam.

¢ Click and hold down the mouse button. The pointer now takes on the form of and
the message Move to where? appears at the bottom of the screen in the Status Bar.
¢ Continue to hold down the mouse button and move the pointer to the position the text

is to appear.

7
o0

When the mouse button is released, the text appears at the current position of the
insertion point associated with the pointer and disappears from its original position.
Note :The drag and drop feature becomes drag and copy if the <Ctrl> key is held down

(5

whilst the text is being dragged. The cursor appears as and the Status Bar
reads Copy to where?.

Special Characters and Symbols
Word has special characters that are not available directly from the keyboard. The

keyboard produces the letters, numbers and punctuation marks needed for most

documents, but some situations call for special characters, like ™, © and 6.

¢ To use the special characters, first position the insertion point at the position the
character is to appear.

% Choose the Insert | Symbol... command to display the Symbol dialog box. This will

display the range of available symbols.
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| T | T[T |S|a|TI|=]| || - |~]|=
. iy A== [=lo[ [ [T [—[T|r|7
L[| 1 —
- +l=llllFlorlwla [nl=[E_
Becently used symbols:
[ele|lv o™ t[z]=]=[+]<[w[n|[a]|[B]
EURC SIGHN Character cods: [2oac From: [Unicods dhesa —1
SutoCorrect. . . I Shortcut Eeyw. .. I Shorbcut key: alk+Cerl+E
Insert 1 cancel |
=

% Change the Font to view more symbols. To position a symbol in the document either

double click on the symbol, or click once and then click on Insert.

% Within the Symbol dialog box, there is an option to [ S pecial Characters ]

select Special Characters. This will give a list of shortcut key presses that can be used
to insert certain symbols. Select Close to exit the Symbol dialog box.

Go To
By using Go To it is possible to move the insertion point to a specific location within the
current document. This includes pages, section, lines, etc.

% Select Edit | Go To.... The Find and Replace dialog box appears.

Find and Replace 71
Find | Replace  GoTa |
Go to what: Enter page number:
Section
Lins Enter + and — bo move relative ko the current
Bookmark location. Example: -+4 wil move Forward Four
Comment items.
Footnots
Endnote ~
= Frevious | Next | close

o

From the Go to what box make a selection.

L)

/7
A X4

Type in the location in the Enter box.
i<

Find | Replace soTo |

Go ko what: Enker pags number:

*

Click on Go To. The screen has moved to the specified location.

*0

>

Click Close to remove the Find and Replace dialog box.

%

Page Numbering can be added to documents by one of two methods.

Insert | Page Numbers

% To add page numbering, select the Insert | Page Numbers... command.
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Eotbon of page (Foo

alignmenk:
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I~ Show number on Firsk page

EFormak. .. I | (] I —ancel I

% Select the Position and Alignment for the page number.

% Click to change the style of numbering.

Poacge MMuanaber Forresaat =1 =<1
rumber Formac: == 3|
I Include chapker oumber

Chapter starks wsuith sewl= Irh=e=aina 1 — 1
Uss separabor: I- e her —1
Examples: 1-1. 11—/~
FPags mumbseri;ma
€= Continue From previoos sec i
« SeEarkE Sk I E‘
| =T 1 —arcel 1

% Select the required style from Number Format. Click OK.
% Click OK again to insert the page numbering.

To Remove Page Numbers

7
*

Select View | Header and Footer.

7
o0

Select the page number.

7
o0

Press <Delete>.

4

¢ This will remove the numbers from the whole document.

L)

Footnotes

Footnotes are a formalised way of documenting sources for quotations, facts and ideas in a
report. A footnote number is automatically placed in the document next to the text to be
referenced. The same number appears at the bottom of the page with details about the
source of the information.

Footnotes can be edited and formatted, just as normal text. If a footnote is deleted, the
footnote reference mark, i.e. the number within the main text of the document, is not
removed. However, if the footnote reference mark is deleted, the corresponding footnote is
removed along with it. Exercise great care when removing footnote reference marks.

There is a widely observed convention that footnotes’ reference numbers are entered in

superscript form.
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% Position the cursor after the word to which the footnote refers. Select Insert |

Reference| Footnote...

ks =r Foermss T1. =. =. .. ~ 1

s rorn mark: (] Srerabol ... (]
Seore ok = =
e S o i | T —1
AEpl chanoe=
ACEle chanoss Do T —1
I Toa=er 1 =l 1 1

% Select whether a Footnote (text appears at bottom of page) or an Endnote (text
appears at end of document) is required.
7

+» Set the Start at number.

% Click OK. The screen changes. Type in the footnote in the given space.

FORMATTING TEXT

Underline, Bold and Italic

As text is entered into a document, it is possible to format it as it is being typed.

From the keyboard

% Activate underline, bold and italic features using the key presses <Ctrl U>, <Ctrl B> and
<Ctrl I> respectively.

% Return to a normal format by pressing <Ctrl Spacebar>, or repeat the key press.

Using the mouse

. A B JF U . .
¢ Click once on the Toolbar buttons — . When a particular feature is in

operation, the 3-dimensional button on the Toolbar appears as if it is depressed.
s Type in the desired text.

% Turn the selected feature off by clicking once more on the depressed button.
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Fonts

A font is a type or style of print. Examples of fonts are Courier, Times New Roman, Modern,
Arial, etc. A combination of the software in use and the selected printer determines which
fonts are available. Fonts may be changed either prior to or after text entry. Change fonts

using the Font box located on the Formatting Toolbar.

Timesz Mew Boman j

0,

% To define a font prior to text entry, click once on the downward pointing arrow and
click on the name of the font that is to be used. The selected font will be used from this
point onwards in the document.

% To change the font of existing text, select the text in the usual manner and then change

the font using the font box. Using this procedure, only the font of the selected text will

be changed. Once the font has been applied, click once elsewhere in the document to
remove the highlight.

s To preview fonts before formatting text, use Format | Font.

Changing the Size of Text
The size of printed text can be changed either before or after the text is typed. The range of
sizes available will be determined by a combination of the printer and font in use. Word

defines size in terms of point sizes - the larger the point size, the larger the character

appears. Size is changed using the Size box located on the Formatting Toolbar.

% To change size before typing, position the insertion point where the new size is to be
applied, then drop down the list from the Size box and select from the available sizes.
The new size will apply until either a new size is selected or the insertion point is
moved into an area of text that is a different size.

% On previously entered text, the size is changed by first selecting the text and then
changing the size using the Size box. The new size will be applied to the selected text
and will appear within the selection. Click once with the mouse to remove the selection.

*

¢ To preview text size prior to changing text selects Format | Font.
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Changing the Appearance of Text

Appearance features are applied using the Format | Font command, which opens up the

Font dialog box. Several features can be chosen at once, as well as obtaining a preview of

the text prior to changing.

Rl

[Fone ==l
Font | =haracter spacing | Text EFFects |
Fonk skwle: Size:
[Ecia Tealic =
Feaular By | = =
Tealic =
BEold 10
I 11
Fonk color: Urnderline skwle: Linderline colar:
I AuEornakic = [crernen el | LaaECrmSEie —1
EFfecks
I Striksthrough I Shadow I Small cap=
I Drouble skrikethrough I Caukline I Al caps
I SuDErscripE I Embass I Hidden
I Subscripk I Enarawe=
Prewisuss
T Trrrces MhWesr o rrscers
This is a TrueTwpe Font. This Fone will be used on borh princer an d screen.
D=Faulk. .. | = [ Zanc=l |

the following appearance options:

% To change the color of text use the Font Color button,

¢ To change appearance before/after typing, open up the Font dialog box and select from

Font Style—— > Regular, Bold, Italic, Bold Italic.

Underline———»includes None, Single, Words Only, Double and Dotted.

Others »Font, Size, Color.

Effects — includes Strikethrough, Superscript, Subscript, Hidden,

Small and All Caps.

Tables and drawing objects

Tables

A

, on the Formatting Toolbar.

Word provides an easy way to create and edit organised rows and columns of tabular data

(without tabs) using the TABLE feature. This is also useful for creating forms such as

invoices that are formatted in tabular form. Tables consist of rows, from top to bottom and

columns that run from left to right, to create CELLS as in spreadsheets.
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< To insert a table, select Table | Insert | Table.... Or use the Insert Table button =
on the Standard Toolbar

0,

¢ The following dialog box appears.

Insert Table =0 =]
Tabls siz=

Humber of columns: = =]

FrMumber ofF powves: IZ E‘
SukboFit behawior

= Fizxed column wideh: |.-:~.utc- E‘

i oubtoFiE ko conksnks

i oaboFiE Eo vaindons
Tabl= skwl=: Tabl= Srid SubtoFaormak. .. I
I Rermember dimensions For news Eables

I [l I Cancel I

% Select the Number of columns and Number of rows required.

7

+* Click OK. The table is visible.

Setting up a Table: Entering Text

Once a table has been created, it is simple to enter text and move around it.

It is probably easier to type the text into the table first and then return to format the table,

i.e. correct column widths, etc.

% Movement forwards within a table is with <Tab>, or click in the appropriate cell.

¢ Use <Shift Tab> to move backwards.

¢ The cursor keys can be used, but are slow when a table is full of text.

* When entering text do not use <Enter>, unless a new line is required within the same
cell, e.g. as in an address.

* Text may be formatted within individual cells in the same way as ordinary text, i.e.

select the text and make it bold, larger, centered, etc.

Selecting Cells
To act on a group of cells they must be selected first, just like a block of text.
To select a cell move the mouse to the left side of the cell. Click once and the cell will be

highlighted.
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To select a row move the mouse to the left of the row. The arrow will change as shown.

Click once and the row will be highlighted.

To select a column move the mouse to the top of the column. The mouse will change into an

arrow pointing down as shown. Click once and the column will be highlighted.

= _E — =

0,

% Dragging the mouse selects a block of cells. When the desired cells are selected release

the mouse. These cells can then be acted upon by the table commands.

Note: To select a row or column, position the cursor within the row/column then use
Table | Select Row or Table | Select Column. Table | Select Table will select the

entire table.

Deleting a Table

% To delete a table it is necessary first to select it.

¢ Either select Table | Select | Table, or click and drag in the selection bar.

¢ Select Table | Delete | Rows or Table | Delete | Columns, depending on which way the
selection was made.

Note: To delete the text only within a table, select the table and press <Delete>.

Merging and Splitting Cells
Cells in a table can be merged or split. To merge or split, the cells must be selected before
choosing the appropriate command.
Merge Cells
To merge cells means to join two or more cells together to make one large cell.
¢ Select the cells to be joined.

¢ Select Table | Merge Cells. The cells are then merged.

Note: Cells from different rows can be merged.

Split Cells
To split means to divide a cell into two or more cells.
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Position the cursor in the cell to be split.

Select Table | Split Cells....

X/
°e

X/
°e

split Cells 71 x|
rumber of columns: El =]
Mumber of rows: [+ =]

I Merge cells before splic

= | cancel |

X/
°

Increase the Number of Columns to the required amount.

Click OK.

S

Note: Cells that have not been merged can still be split.

Inserting and Deleting Cells

It is possible to insert cells into a table.

Insert Cells

el x|

i Shift cells right
= SRIFE cells dowini

i Inserk entire rowve
i In=erk enkire calumn

| ks I Cancel I

o0

Select the cell.

7
o0

Select Table | Insert | Cells.... A dialog box opens.

o

The options are:

L)

Shift cells right, which will insert the new cell and move the other cells to the right.
Shift cells down, which will move the cells down after insertion of the new cell.
Click OK.

Delete Cells

L4

% Deleting cells is a similar process.

DS

» Select the cell to be deleted.
Use Table | Delete | Cells.

K/
X4

D)

>

K/
*

% From the dialog box select either Shift cells left or Shift cells up.
% Click OK.

Page 74 of Federal TVET Agency |Basic Agricultural Production and Natural

125 Author/Copyright Version -1

Resources Conservation Level-I October 2019




eI gy

e >
L
b Qb

It is easy to increase a table in size by adding rows or columns to the edges, or even

Inserting Rows and Columns

between existing rows or columns.

Insert rows or columns

% Move to where the new row/s (above the cursor) or column/s (to the left of the cursor)
is to be inserted.

¢ Select Table | Select Row (or Column) to select the row/column. Select Table | Insert |
Rows (or Columns).

% The new rows/columns are then inserted.

¢ To insert more than one row or columns select by highlighting the required number of
rows/columns before using the Select and Insert commands.

% Alternatively, position the cursor below where the new row is to be inserted and click

=

on the Insert Rows button, = , from the Standard Toolbar. Highlight a column
and the button will change to Insert Columns.

Delete rows or columns

¢ Select Table | Select | Row (or Column).

¢ Select Table | Delete | Rows (or Columns).

To add more rows to a Table place the cursor in the last cell of the table and press <Tab>.
New rows are added accordingly.

Alternatively, when a row or column is selected the Insert Table button changes to Insert

Rows, , or Insert Columns, . Click once to insert the appropriate item.

Borders and Shading....
+ Position the cursor within the table.
% From the menu select Format | Borders and Shading ....
% Make a selection from Setting:. Choose the line style by clicking on it from the Style
box.

% Click OK.
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Click the Borders button & ~ from the Formatting Toolbar and choose where the

borders will appear.

Shading can be used to enhance the appearance of a table or to call attention to a
particular cell. A few minutes spent adding lines, merging and splitting cells and adding
some shading, enhances the appearance of a document drastically.

¢ To shade cells, select the cell or group of cells.

% Select Format | Borders and Shading... and select the Shading tab.

i ==

B ool oo =i
Borders | Boaos soraer  [EREHSE] |

1
1
-
1
i
]
i

I rmeFEm

IR
i
LN
I

e
More colars. .. |

::::::::

Al o

== —1

=1
I O =1
Show Tootar | __ormonaicioe... | == 1 o |

¢ From the Fill box, choose the required Shading.
% Click OK.

Converting Text to a Table

Word allows previously entered text to be placed into a table providing the text is
separated by either commas, tabs or paragraph marks. It may be necessary to remove any
extra commas or tabs to reach the required format.

¢ Select the required text.

¢ From the menu select Table | Convert | Text to Table....

% The Convert Text to Table dialog box appears allowing specification of number of

columns and rows.

E T esxrk Eax T .abille ?I XI
Table size
rumber oF coluamms: —
rurber oF o= I —
autoFiE behassior
= Fixed columm wsideb: | == —
£ SaukbEoFEiE Eo conmbkenks
£ B FIE o wsiricloees
Table sktwle: Criored SutoFormac. .. ||
Separabkse Eexk ak
= pParagraphs T Conmrmas
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+» Click OK.

®,

% The text will now appear in table format.

% Borders/Shading can be added accordingly.

Note: To convert a table into text, select the table and from the menu choose Table |
Convert | Table to Text. From the Separate text with dialog box, choose how the
text is to be separated. Click OK.

Sorting

Sorting can be carried out by any column and secondary sorts can be applied, if required.

0,

¢ With the cursor within the table, select Table | Sort....

7

¢ The Sort dialog box is now displayed.

T = ascending
- Twoe: | —1 =
I == e Tk T Descen ding
Usimg IFar=saraphs=s el |
Then by
I =1 Tvee: [Few =1 = &scsrndins
. Cr==cer dimg
Usima:  [FParaaraph= —1
rs lisk has
£ Header rowve =" rlo header rows
Spkions. .. | =1 1 ancel |

¢ From the Sort By box select which column is to be sorted.

/7
A X4

From Type select if it is text, number or date.

/7
A X4

Choose to sort in Ascending or Descending order.
Click OK.

A X4

Note: If the My List Has Header Row is checked then the Sort By choices will show the

column headings.

Drawing a Table

Tables can be drawn within Word, very handy when trying to recreate forms, etc.

R/

¢ From the menu select Table | Draw Table.

R/

¢ The Table toolbar will appear and the mouse will change to a pencil.
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¢ Draw the table by positioning the mouse over the page and click and drag to draw the
table. Draw subsequent lines in the same way.

+* Once the table has been drawn click on the Draw Table button,, to remove the

pencil.

++ Use the Eraser, , to remove lines.

=)

% Highlight the Rows/Columns and use the Distribute Rows, [=%] or Columns,

Evenly buttons to make the selected rows/columns heights/widths even.

B
¢ Select the required text, then click the Change Text Direction button, i , to change

direction of the text.
¢ Format it in the usual way either by using the buttons on the toolbar or by using

Format | Borders and Shading.

OBJECTS

WordArt
WordArt is a facility within Word that allows special text effects to be created.
» From the menu, select Insert | Picture | Word Art.... Select a style from the

WordArt Gallery then click on OK.

=
Seleck & W ordark skl
T5""‘*’f“fﬁ5ﬂ"‘|mrc--""‘mrt wsoraar, [Woranrt [Woraar: [ M
WLl d | | Word Axt | |Word@urt v o e 5 e | o —;:: -
WerdArt | ... Worcrt ||| Word.a e Y
WiordAss [WaordAve | MardBeh || O0fmilleg sl ':l -
[ == 1 cancel |
- |
Eork: Simes:
[T tmpaee =1z =1 = | = |
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In the Edit WordArt Text box, type in the text, choose a font style and size.
Click OK to show the text entered.

The WordArt toolbar appears.

From the WordArt Toolbar, click a box to change the effects.

Choose Word Art shape to change the shape of the text.

> v v Y VYV

Click on the background to return to Word and view the WordArt. Click once on the
text to view the handles. Resize if necessary. Click and drag to move. Click and drag
the yellow handle to change the slant of the text.

a To edit WordArt text, double click on it. Select View | Toolbars | WordArt to view
the WordArt toolbar.

Insert AutoShapes

To insert an AutoShape

A From the menu select Insert | Picture | AutoShapes.

A The AutoShapes toolbar appears.

Connectors Block Arrows Stars and Banners

Autoshapes

Lines R e More AutoShapes

Basic Shapes Flow Chart Callouts

A Select an AutoShape button and choose a shape from the list.

a Position the mouse over the page where the shape is required, click and drag to
draw the shape.

A Resize using the usual techniques.

a Use the yellow handle, where possible, to reshape the AutoShape.
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Use the green handle to rotate the AutoShape.

Move the shape by positioning the mouse over the shape until the mouse pointer has
a four headed arrow on it. Click and drag to the required position.

The shape can be formatted as required using the drawing toolbar or Format | Auto
shape.

Select the AutoShape and press <Delete> to delete it.

Hold <Shift> whilst drawing to create a shape of the same proportions.

Drawing

Drawings can be easily created within Word.

A From the menu, select View | Toolbars | Drawing, to view the Drawing toolbar. Or

click on Drawing

Creating/Deleting a Drawing Object

By using the different buttons on the Drawing Toolbar, different shapes can be created.

a To draw a shape, select the required button.
A Move the mouse to where the shape is required. Click and drag to create the chosen
shape.
& Holding <Shift> whilst drawing a line, will draw a straight line or force it to 30°, 45°
or 60° angle.
a Holding <Shift> whilst drawing a circle/square/AutoShape, etc., will keep the object
in proportion.
A Click once on the shape to view the handles.
a Position the mouse pointer over any of the handles and resize if necessary.
Deleting objects
a To delete a drawing object, click on the shape once to view the handles.
A Press <Delete>.
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Formatting Drawing Objects
Once a drawing object is created it can be formatted to adjust the colour, style and
thickness of the lines and the colour and pattern that fill the object.

a C(Click once on the object to be formatted. From the menu, select Format |

AutoShape.
oo [— St I =l
Cashed —— =1 wetesighk o 75 =c —
P
EBegin stwle: | Ll Ernd scwle: | Ll
Eooin si=e: | =1 Era size: I =1
[ == 1 —anc=l ]

a Select the appropriate tab and choose the required options.

MS-EXCEL

Starting Excel
To start excel

& Click Start

4 Point on All Programs

4 Point on Microsoft office

4 Then click Microsoft Excel
Spreadsheet Principles
A spreadsheet package is a computer program created specifically to help in the processing of
tabular information, usually numbers. The spreadsheet stores information in rows (across the
screen) and columns (down the screen), forming a worksheet (the Excel term for a

spreadsheet).

The Layout of the Excel Screen
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Title Bar - Indicates application and current workbook in use
Menu Bar - General headings for accessing commands
Standard Toolbar - Quick access to basic features of Excel
Formatting Toolbar - Quick access to change appearance of cells
Formula Bar - Indicates active cell address and displays cell
contents
Scroll Bars - Allows quick movement around the worksheet
Active Cell - Position to insert information
Status Bar - Displays information about the selected command

and to the right, the state of certain keys e.g. CAPS,
NUM, etc.

To Exit Excel:-From the Menu Bar click on File. A drop down menu will appear.

Place the mouse pointer over Exit and click once.

Save, open and close workbooks

Saving a newly created workbook

 Select the File menu and choose the Save As... Command.
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% The Save As dialog box will then appear on the screen, in front of the current

&

worksheet.
% Enter the name of the file in the File name box.
% Select the correct drive from the Save in: box.
% Click to save.
Note: When a new workbook is to be saved, selecting Save displays the same dialog box as
save as.
Saving a Named Workbook
# Select File | Save to update a document that has already been named.
Closing a Workbook
To close the current, open workbook from the screen and begin working on a new one:
# Select the File | Close command.
# If the workbook has not been previously given a file name, or if it has been modified in

any way, Excel displays a Message Box.

ricrosoft Excel x|

& Do wou wank to sawve the changes vou made to 'BEookl '7

# Three options are given:
Yes displays the Save As dialog box if the workbook has just
been created or automatically saves the workbook if it has

been modified.

No closes without saving
Cancel returns to the active worksheet without closing or saving
Starting a New Workbook

A new workbook can be opened at any time within Excel:
# Select File | New the New dialog box is displayed, click OK.
@ A new workbook is opened, pushing any other open workbooks to the back. The new
workbook is named by default using the next number in the sequence e.g. Book2.
@ Any other open workbooks can be brought to the front using the Window command on

the Menu bar and selecting from the open workbook list at the bottom of the menu.
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The open workbooks are numbered, click on the one required, to display it.
Opening an Existing Workbook
Once a workbook has been created and saved, it can be opened at any time.
# To open an existing workbook, select the File | Open command. This will display the
Open dialog box.
@ Use the drop down list of Look in: to select the correct drive and folder, from which to
open the document.
@ Finally, click on the name of the file to be opened. This will now be highlighted.
# (lick the Open button to open the file. (Double clicking the file name in the list also
opens the file).
Opening recently used workbooks
» The last four Workbooks that have been used by Excel are listed at the bottom of the
File menu. Click once on the file name to open the file - the file must, of course, be on one

of the disks currently being used by the machine.

Workbooks

Using Sheets
Workbooks are made up of worksheets named Sheet1, Sheet2, etc. The worksheet tabs are

arranged across the bottom of the worksheet window.

e |
M 4 b M| Sheetl { Sheet? £ Sheetd /

Ready

e C(lick on a worksheet tab to display a particular sheet
By default there are only 3 sheets to a workbook. The maximum number of sheets that can be

set in a workbook s 255.

To change the default number of sheets in a workbook

e Select Tools | Options and the General tab.
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Color I Inkernational I Save I Error Checking I Spelling I Security I
g I Calculation I Edit : Transikion I Cuskom Lisks I Chark
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I R1C1 reference skyle I~ Prompt for workbook, properties
I Ignore other applications I Provide feedback with sound
™ Function toaolkips ™ Zoom on rall with IntelliMouse
¥ Recently used File list: |4 E‘ entries weh Options. .. |
Sheets in new workbook: |3 E‘
Standard Font: |P.ria| ;l Size: |10 LI
Default file location: IC:'l,DDcuments and SettingshadministratariMy Do
Ak startup, open all files in: I
Uset namme: |17 Manager

Ok I Cancel

¢ (Change the number within Sheets in new workbook.
e Click OK.
e Every new workbook started after this will contain the new amount of sheets.
Moving around the sheets
When more sheets are added or more descriptive (longer) sheet names are used they take up

more space and can become hidden.

IH 4 ¢ M|“Summary ; Data Entry £ Totals for 2000 # Totals for 2001 £ Tokals for 2IZII|1|
Ready

When this happens the movement buttons on the left are then used to show hidden sheet tabs.

K% Summary £ Data Entr

ady

First Left Right Last
Renaming Sheets
To rename a sheet
e Double click on the required sheet tab or select Format | Sheet | Rename.

e Type the new name.
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e Press <Enter> or click away from the sheet tab to complete the renaming.

Note: Sheet names can include punctuation e.g. spaces and be as descriptive as required to

% Totals for 2001

relate to the contents.

Insert and Delete Sheets
Individual sheets can be added to, or deleted from, any workbook.
To insert a sheet
Either
e Select Insert | Worksheet.
or

e Rightclick on a sheet tab and select Insert.

=

16 Insert...

17 Delete

18 Renarne

19

N Maove or Copy,..
21 Select All Sheets
g; Tab Calar..,

24 G iew Code

M 4 F M r\., Sunmatsy },Data EWFTFUTHFFDTTDUD_,{
Ready

e (Choose Worksheet and click OK.

To delete a sheet
e C(lick on the sheet tab to make the required sheet active and either
e Select Edit | Delete Sheet

or
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e Right click on the sheet tab to delete and select Delete.

Microsoft Excel x|

& Drata may exist in the sheek(s) selected For deletion. To permanently delete the data,

press Delete,
Cancel |

¢ Confirm the deletion by clicking Delete.

Editing in worksheets

Overtyping

Overtyping is used to replace data in cells by typing new information.

Editing by Overtyping

@ Click on the cell to be changed.

# Enter new data.

# Any time before <Enter> is pressed, the user may click on the Cancel button on the
formula bar or press <Esc> which will cancel the new input, leaving the originally
entered data unchanged.

@ Press <Enter>.

@ After completing the cell entry the new information replaces the old.

Undo/Redo
When editing a worksheet, the last change made can be Undone by selecting either Edit |
Undo .... Or the Undo button, =7 ™.

After completing a replacement entry, this action can be undone with Undo.

# Select Edit | Undo or click Undo button 7 to reverse the last action.
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@ After Undoing an action, it can be redone by selecting Edit | Redo .... or clicking the
Redo button £,

All actions that can be undone are stored in the Undo history. To use:

@ Click the drop down list next to the Undo button ¥ =
@ Select the number of required Undo actions to a maximum of 16.
Editing Cells
Cell contents can be changed by editing when the information is more complicated and

overtyping becomes impractical.

Formula bar editing
@ Click on the cell to edit and click in the contents in the Formula Bar.
@ The cursor can be moved around using the cursor movement keys and the Home and
End keys.
@ To complete the entry press <Enter>. Other keys such as the down cursor do not
complete the entry after editing.
In-cell editing

Editing can take place directly in the cell.

@ Place the cursor within the cell.
@ Double click to start In-cell editing.

The same rules apply as with Formula Bar editing.

@ Any part of a cell’s contents can be formatted, by clicking and dragging, during the edit
process.
Erasing Data

The contents of cell/s can be erased by:

# Clicking on the required cell or highlight a group of cells.
@ Select Edit | Clear | Contents.
Note: Selecting All clears contents, comments and any formatting. Formats clear all the

formatting and leaves the contents. Comments only clear the cell comments.
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Copy, Cut and Paste Cells
The copy command can be used to copy labels, values and formulas of a single cell or a group of

cells to other areas of the worksheet.

The selected cells are placed in an area of Windows called the Clipboard, from where they can

be pasted back into the required place.

Copy
@ Select the cell or cells to be copied.

# Select Edit | Copy or the Copy button, on the toolbar.
Note: Excel places a marquee (a dotted line around the selected cells to be copied).
Paste
@ Select the cell or click and drag a range or select the top left cell of the paste area for a
range.
Click Paste B2 | ifrequired, more than once (see Note) Or
# Press <Enter>, to paste and clear the clipboard.
Note: When using Paste, the original cell can be pasted repeatedly whereas <Enter>
terminates the copy process.
Cut

# The same as copy except the original cell/s are removed after pasting.

# Edit | Cutor click i .

@ Select destination cell and Edit |Paste or e or press <Enter>.
Paste Special
Paste Special is used to paste cell information when a straight forward copy is not required.
Examples of when to use Paste Special:
To combine 2 ranges by adding, subtracting, etc.
To transpose a range (rows to columns and columns to rows).
To convert formulas to values by pasting to the same location.

To use paste special
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3 Highlight cell/s to copy.
3 Select Edit | Copy or click or right click and select Copy.
% Place active cell at the destination cell.
3 Select Edit | Paste Special.
Paste Special = ==l
A et Boraene
€ Columm waidehs
« Formulas and mumber Formaks
T walues and number Faormakes
M Skip blank=s I Transpos=
Faste Link I [ == 1 cancel |
% Choose the required options.
# Click OK.

Note: Use of the Paste Link button is covered in a later section.
Move & Insert Cells by Dragging
Moving cell contents
# Highlight the cell /range to move.
# Place the cursor at the edge of the range (move cursor - white arrow).
# (Click and drag to the new location.
# Release mouse button to move.

Note: This method is quicker than cut and paste described in an earlier section.

Inserting cells by dragging
Ranges can be moved from one location and inserted into another without first clicking on the

destination cell in which it is to be placed.

# Highlight the original range.
# Hold <Shift> and click and drag the edge to the new location.
Note: Holding <Ctrl Shift> copies and inserts.

Delete Cells

Cells can be deleted from a worksheet and the space left is filled by the surrounding cells

moving in.
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To delete cells

3 Highlight the required cell/s.
% Select Edit | Delete.

% Select the direction to move the remaining cells.

Total Incorme

feT=1=1 ==, ===

Hent

j=]m]

Holiday =

Leisure

De=lete

(nflongit 7 |-

Electricitey

Sas

Telephone

Zar

Petrol

Food

Y Y
RN

COthers

=] o+« E,?,h“:t c=ll= I’EF,?

Note: Entire rows and columns can be deleted via this menu but they are normally deleted

by selecting the rows or columns headings before selecting Edit | Delete. This deletes

them directly.
# Click OK.
4 |Total Income 385 355 355 400
5 |Rent 80 50 50 50
E |Electricitey 49 o o 43
7 | Gas 45 [} [} a1
g8 |Telephone u] =ri o o
9 |[Car u} [} a1 [}
10 [Petraol 20 25 25 20
11 |Food B0 [=1n] [=1n] =)
12 |[Others 55 45 100 55
13 |Total Expenses 310 247 356 334
14 |Savings 75 138 167 233

# The above diagram shows the same worksheet with the cells below moving up to fill the

space left by deleting the highlighted cells.

Note: This option removes the entire cells and their contents. To delete contents, formatting

or notes use the Edit [ Clear menu, this leaves the cells in place.

Editing cells:

Bold, Italic and Underline

Formatting is changing the way cells look in order to improve readability, appearance and ease

of use.

Applying bold, italic and underline

# Highlight the required cell/s.

# Select Format | Cells, Font tab.

# Choose the required formatting from within Font Style and Underline.
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Note: When using the Format dialog box all selections are previewed to show what the
results will look like.

# Click OK to add the formatting.
From the keyboard

@ Select the cell/s.

# To add Bold, press <Ctrl B>.

# To add Italic, press <Ctrl I>.

# To add Underline, press <Ctrl U>.
For part of a cell only, while entering

# To start Bold press <Ctrl B>, type text and <Ctrl B> to turn bold off.

@ To start Italic press <Ctrl I>, type text and <Ctrl I> to turn italic off.

# To start Underline press <Ctrl U>, type text and <Ctrl U> to turn underline off.
Part of a cell only, while editing

@ Enter edit mode by double clicking on the required cell or press <F2>.

@ (Click and drag any part of the cell contents and use any method described previously to

add the required formatting.
# Press <Enter>, to exit edit mode.

Using the mouse

@ Select the required cell/s and click once on the required toolbar button from B £ I

@ When a feature is in operation the button changes color and appears to be pressed.
Removing bold, italic and underline

@ Select the required cell/s.

@ Turn off by clicking once on the depressed button.
Change Font and Font Size
A fontis a type or style of print. Examples of fonts are Arial, Roman, Modern, Script, etc. A
combination of the software in use and the selected printer determines which fonts are

available for use.
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The default font is Arial, 10 point. Font size is measured in points. There are 72 points to 1

inch in height.

# Select the range.
@ Select Format | Cells.
@ Select Font tab.
# Select Font from Font box and Size from Size box.
Note: Text can be typed into these boxes, especially the size box, when a size is not displayed
in the list.
@ Check the Preview box for an example of the chosen options.
Change of base font and size

To change the base font for all new workbooks:

@ Select Tools | Options, click the General tab.
# Choose the required Font and Size.
# The changes will only take effect after Excel is restarted.
Format Numbers
Numbers can be displayed in various formats with options for decimal places and the display

of negative values.

Formatting numbers
# Select the range.
# Select Format | Cells.
# Choose the Number tab.
@ Select required Category, Number of decimal places and Negative number display (for
currency).
@ Check the sample box.
# (lick OK to apply the chosen formats.
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Date and Time

Date and Time is stored as a number including a decimal part. The whole number represents

the number of days since 1 January 1990 and the decimal part represents the time as a fraction

of a day.

Formatting date and time
e Select the range.
@ Select Format | Cells.
# Choose Number tab.
@ Select Date or Time in Category and the required format from within Type.
@ A preview is available in the Sample box.
Note: Elapsed time calculations are carried out by subtracting one time from another.
Alignment
Alignment is the positioning of text in a cell relative to its edges. By default Labels (Text) are

aligned to the left and Numbers to the right.

Aligning cell contents
# Highlight the required range.
# Select Format | Cells | Alignment tab.

et = T =1 _>=1

o e N PRt | ok ] EBorder || Pattsrns | Proesceion ||

Te=sck aliamme
Horizomkal

=t -

s=r=r= —1 T -

wrerkical: =] =

b = -

Iscream —1 = =

K Ou=kifFw diskribobed -
Te=kE conbErol -

L) R N __

I =hrinlk o Fike lC' E Degrea=

I meragse cells

Fight—Eto-leFe

Te=>=k direckicm:

==rt==x —1

@ Select the required option from within Horizontal (choosing Left (Indent) optionally
enter the amount in the Indent box, changing the Indent automatically selects Left
(Indent) in the Horizontal box).

@ Select the required option from within Vertical.
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# Click OK to apply the formatting.
Text Wrap
When text needs to fit a cell without widening the column, text wrap can be used.
To apply text wrap

e Highlight the cell/s.

e Select Format | Cells and the Alignment tab.

e Check Wrap text under Text control.

e C(lick OK to apply the formatting.

= | =] | [ (=]

Excel Course Motes Book 1

Lesson 1
farmatting =

N ||

Merge
Merge and centre is used to centre a title across a range of cells, either horizontally or
vertically.
e Enter textinto a cell.
¢ Highlight the range starting with the cell that contains the text.
¢ Select Format | Cells, Alignment tab.
e Under text alignment, select Center (vertical or horizontal, as required).
e Check Merge cells under Text control.
e C(lick OK.
To remove merge and centre
e Highlight the merged cell.
¢ Select Format | Cells, Alignment tab.
e Uncheck Merge cells under Text control.

e (lick OK.

Note: The Merge and Centre button does not remove merged cells as in previous

versions.
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Text Color
Text color is called Font Color.
To change font color
e Highlight the required range.
e Click the Font color button ‘£ = to change to the displayed color or
e Click the [=] to display the drop down list and choose from the palette of colors.
Cell Borders
Lines are added to worksheets via Cell Borders. Options are given on line style and location
within the cell or range of cells.
To add cell borders
o Select the required cell/range.
e Select Format | Cells and Border tab.
e Choose from Style, Color (if required) and then from either Presets or Border to add
lines to the required areas.
Cell Shading
Background cell color is added to cells to enhance the appearance of worksheets.
To add cell shading
e Highlight the required range.
e Click the Fill Color button " ~ for the default color or
e C(lick the down triangle to display the range of colors.
e C(lick on the required color to apply to the range of cells.
To add cell patterns
e Highlight the range and select Format | Cells and Patterns tab and choose from
Pattern.
e C(lick OK to add pattern and color.

Formatting worksheets

Long Labels

Along label is text that is wider than the cell into which it is entered.
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If adjacent cells are empty, then the text flows into them, as when entering titles.
If the adjacent cell is occupied, then the label is truncated (the cell only shows what it can). The
label can still be seen in the formula bar.

A t = Lesszon 1 formatting
= I =] [ < [ =] [ E

Excel Course Motes Book 1

Lesson 11l (=1
=

(0|00~ @t & | W K=

Y
=0

To display long labels
e Widen the column so that the label fits Or
¢ Reduce the size of the font so that the label fits or
e Apply the formatting features Word Wrap or Shrink to Fit (both covered in the next
section).
Change Column Width
Individual column widths can be changed in a number of ways:
Using the menus
¢ Place cursor anywhere in the column to change.
¢ Select Format | Column | Width .
¢ Enter the column width in character units (the default column width is 8.43).
e C(lick OK.
Using the mouse to change column width

e Point in the Column Border, at the border between two columns, the mouse pointer

changes to "I"
¢ (licking and dragging to the left or right now alters the width of the column to the left

(Take care when dragging left as width 0 hides the column).
Click and drag to change the

1 e ! = ! = width of column A

= Excel Course MNotes Book 1

=g

= Lesson 11 =

=
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To adjust multiple columns
¢ In the column headings, click and drag to select the required columns.
¢ Display the adjust cursor at any vertical column edge within the range.
e C(lick and drag one column border to change them all or double click to adjust all
columns to the widest entry within each column.
Change Row Height
Row heights can be changed in exactly the same way as changing column widths, except the

adjust cursor is between two rows and the adjustment changes the row above.

Using the menus
¢ Place cursor anywhere in the row or click the row number to change.
e Select Format | Row | Height.
¢ Enter the row height in point size (the default row height is 12.75).
e (lick OK.
Using the mouse to change row height
e Point in the Row Border, at the division between two rows, the mouse pointer changes
to -+
e C(licking and dragging up or down now alters the height of the row above (careful when
dragging up as a row can be hidden - 0 height).
To adjust multiple rows
¢ In the row headings, click and drag to select the required rows.
¢ Display the adjust cursor at any row horizontal edge within the range.
e (lick and drag one row border to change them all or double click to adjust all rows to
the highest entry.
Note: If row height has not been manually changed then an increase in font size

automatically increases row height to display the text correctly.
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Insert Rows and Columns
To insert entire rows or columns
e C(lick on a cell or a range of cells (remember new columns are inserted to left and new
rows are inserted above).
e Select Insert and then either Rows or Columns.
To insert a group of cells
¢ Highlight the range of cells to insert.
e Select Insert | Cells.
e Choose the required option from Shift cells right and Shift cells down.
e (lick OK.
Delete Rows and Columns
To delete rows, columns or a range of cells
e Highlight the appropriate row/column/cells.
o Select Edit | Delete.
e Choose the required option in the Delete dialog box.
e Entire rows or columns may be deleted or just selected cells, moving the surrounding
cells up or left to fill the gaps.
e Selecting the row number or column letter before selecting Edit | Delete will delete the
row or column without displaying the Delete dialog box.
Note: The results in cell formulas may be altered by deleting parts of the worksheet,
resulting in errors, indicated by #REF in the cells.
Hide/Unhide Rows and Columns

Rows or columns of data can be hidden when the data is not required to be seen.

To hide a row

¢ Drag the adjust cursor -I- up (effectively making the height 0).
or
e Select Format | Row | Hide.

To hide a column
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¢ Drag the adjust cursor "l" left (effectively making the width 0).

or

¢ Select Format | Column | Hide.

Note: Dragging the adjust cursor across several columns or rows hides multiple

columns/rows.

To unhide rows

¢ Highlight the rows above and below the hidden data.

¢ Select Format | Column | Unhide.

To unhide columns

e Highlight the columns either side of the hidden data.

¢ Select Format | Column | Unhide.

Functions

Functions are specialized formulas that make calculations easier. There are various types,

some examples include:

Statistical
Financial

Logical

Math & Trig

Text

Date & Time

Lookup & Reference

AVERAGE, COUNT, MAX, MIN, STDEV, VAR
NPV, FV, PMT, RATE, IRR
IF, TRUE, FALSE

MOD, SIN, LOG, SQRT

LEFT, RIGHT, MID, LEN

DATE, NOW, TIME
HLOOKUP, VLOOKUP, CHOOSE

All functions, like formulas, are preceded by an = sign.

=SUM (N12:N16) adds the values in the range N12:N16 and is equivalent to the formula

=N12+N13+N14+N15+N16. The bigger the range the more effective the function. To add

5000 numbers in a column is just as easy as adding 3 numbers.

The syntax (the makeup) of a Function is as follows:

= Function Name (arguments, separated by commas)
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Insert Function

Insert Function helps in the entering of functions and replaces the function wizard in previous

versions of Excel. To enter a function:

e (lick the Insert Function button Fa
insert Function 2]

Search For a function:

Or select a category: |Most Recently Used LI

Select a Function:

sSUM{number1,number2,...)
Adds all the numbers in a range of cells.

Help on this Function Ok | Cancel |

to display the Insert Function dialog box.

e Select from the Function category (a small description is displayed, for further help,

click Help on the function).

e Select the required function from within Select a function..

e (lick OK (the specific function dialog box is displayed).

e Select or type in the arguments (ranges or cells, different functions require different

information).

e (lick OK to complete the function entry and display the result.

Common Functions

Sum

This most common of all functions and adds a column or row of numbers. As SUM is the most

common it has been placed on the standard toolbar and the button is called AutoSum

e Select the cell where the sum is required.
e Click the AutoSum button = .

¢ The function is entered with a suggested range.

=

¢ [t uses the numbers in close proximity to the active cell. If the range to sum is incorrect
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(it stops at a blank cell), click and drag the required range.

¢ Press <Enter> to complete the function and enter the result.

sur ~ 2 J A& =SUMBE11 BT
A [ B | c [ D [

L1

=

3 Apoples Pears Cranges

4 | Jdan =] =] =]

5 |Feb 4 3 =2

B |[Mar 5 4 3

7 |Total ko 1454 135 11

g8 | Apr =] =] 4

9 | May 1 =2 o

10 | Jdun =] [n] =]

11 [Total E T4y 7 12

12 [Grand total =suUnEIKIEE

1=

Note: If numbers have been summed to create totals then the AutoSum button sums the sub

totals and ignores the individual numbers, in effect creating a grand total.

All other functions can be entered using the Insert Function button P , although they can be

typed if the correct syntax is known.
Average
The AVERAGE function combines a simple formula, a sum divided by a count. An example of
the function:
=AVERAGE (C5:C19)
To enter the Average function

o Select the cell where the Average is required.

e (lick the Insert Function button P to display the Insert Function dialog box.
insert Function 21|

Search for a Function:

Type a brief description of what you want to do and then GO |

click Go

Or select a category: IMost Recently Used LI

Select a Function:

IF
HYFERLIME
COUMT

MAx
SIM LI

AYERAGE{numberl,numberz,..}
Returns the average (arithmetic mean) of its arguments, which can be
numbers oF names, arrays, or references that contain numbers.

Help on this function oK I Cancel
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e Select Average from within Select a function.

¢ C(lick OK to display the Average function dialog box.

Function Arguments illl
AYERAGE
Number1 | SEHH = {6;2;3;11;3;6;4;13;1
MumnberZ I :“J =

Returns the average {arithmetic mean) of its arguments, which can be numbers or names,
arraws, ar references that contain numbers,

Number1: numberl, numberz, ... are 1 ko 30 numeric arguments For which you want
the average.

Formula result = -]
Help on this Funckion K I Cancel |

e [f the range taken from the numbers suggested in the Number 1 cell matches the
required range, click OK.

If not,

e (Click the collapse button, , to return to the worksheet to select the required range.

or

Note: Click on the expand button E to review the dialog box.

e Typein the arguments in Number1.
e (lick OK to complete the function entry and display the result.
Count
Count is a statistical function that only counts non-blank numeric cells (0 is counted, blank cells
are not). Countis used to analyze large lists where the data changes frequently.
Max
Max (maximum) is a statistical function that returns the largest number in a specified range.
Min
Min (minimum) is a statistical function that returns the smallest number in a specified range.
When used together, MAX and MIN give the spread in a range of numbers.
Standard Deviation
The STDEV (standard deviation) is a statistical function and is a measure of how far values vary

from the average.
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There are other variations of standard deviation:

STDEVA

STDEVP
DSTDEV

DSTDEVP

IF

Statistical function, standard deviation based on a sample including

logical values and text

Statistical function, standard deviation of an entire population

Database function, standard deviation of a range in a database

database

Database function, standard deviation of an entire population in a

The logical function IF compares the contents of a cell and, if a logical test is met, performs one

action and, if not, performs another.

e Select the cell for the result.

Click the Insert Function button

Select Logical from the Function category.
Select IF from within Function name.

Click OK to display the IF function dialog box.

IF
I.ogical_testl _5".] =
\u'a\ue_if_truel _’s_] =
Value_iF_Falsel _’a.] =

Checks whether a condiion is met, and returns one value if TRIJE, and another value if

FALSE.

Logical_test is any value of expression that can be evaluated to TRUE or FALSE,

Farmula result =

Help on this function

Cancel |

e Asan example:

For Logical test enter A1<10

In Value_if true enter A1*3

In Value_if false enter A1*2

P to display the Insert Function dialog box.
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¢ C(lick OK to complete the entry

e Enter a number in Al and if the contents of cell A1l is less than 10 then the number is

multiplied by 3, if not, the number is multiplied by 2. The function is expressed as:

=IF (A1<10, A1*3,A1*2)

e The IF function is sometimes described as IF Then Else. IF the condition is true, then do

these, Else do that?

Charts

Charts

It can be difficult to find vital information like changes in trends or performance from rows and

columns of numeric data. A picture of the figures - a graph or chart, helps to identify subtle

changes that may have otherwise been missed. Charting data is quick, easy and flexible

Creating Charts

To create a chart

¢ Using the mouse select the data you want to create a chart of.

e Select Insert | Chart or click the Chart Wizard button 1] .

Chart Wizard - Step 1 of 4 - Chart Type

Standard Types | Custem Types |

Chart byps:

i
. WY (Scatter)
halyy ~rea

@ Doughnut

Chart sub-typs:

Ll |
(el

lustered Column. Compares walues across
ategories.

[ —— d Hold to Views Sample |

cancel | cpack [ mexe= | Einish |

e Select from Chart type.
e Then from Chart sub-type.

Note: The chart can be viewed by holding Press and hold to view sample. This only works

when a range has been selected first.
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e (lick Next>.
o Step 2 of the Chart Wizard.

Chart Wizard - Step 2 of 4 — Chart Source Data 2] ]|

Data range:

Series in: = Rows

 Colurnns

cancel | =gack [ mest> | Einish |

e Check or enter Data range (the data to be charted) and Series in, check rows or

columns to match the data.

Note: To select a data range click on the collapse button E in the Data range box. Click

and drag a range. Separate each data range by a comma. Press <Enter> or click.@
to continue.
e C(lick Next>.

i | Axes I Gridiines I Legend I Data Labels I Data Table
Chart kitle:

I 500
00 -

Cateqory (=) axis;

I 500 -
S 500 -
alue () axis:
A oo f i

I 300 H L
Second cakagory (X)) axis: a00 M | o

I o0 H L
Second walue (¥) axis: a

I dan Feb Mar Apr Bay Jun Jul Aug

Cancel | < Back I Mext = I Einish |

e At step 3 complete the required Chart Options. Remember to view each of the tabs to

see the available options. There may be six tabs.
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e (lick Next>.

Chart Wizard - Step 4 of 4 - Chart Location 7| x|
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I fxes | aridlines | Legend | Drata Labels | Data Tal:ulel

Place chart:

" as news sheek:

wl
T
T
g[._LE ¥ ac ghject in:

IChartl

T - |

Zancel | < Back. | Mexk = | Einish I

o Select either, As new sheet and name the sheet (Default Chart1), or, As object in and

select a sheet to place the chart (Default is the active sheet).

e C(lick Finish to create the chart.

Formatting Charts

To format a chart

e Select the part of the chart to change (place the cursor over it and click) and select

Format Selected ... or

e Double click on the required part.

e The Format dialog box is then displayed for that part of the chart (some parts have a

tabbed dialog box). Make the changes, as required.
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H I Scale I Font I Mumber I Alignment I

rLines rTajor tick mark bvpe
= Aukomatic " Mone = Outside
" Mone " Inside i Cross

7 Custom
Mmoot kick mark type——————————
Skyle: Ii vl =
i+ None 7 Outside
Color: I Autornatic vl i Inside i~ Cross

w'eight: —Tick mark labels
" Mone ~ High
—Sample i Low f* Mext ko axis

Ok I Cancel I

e The above picture is the dialog box used to format an axis. Use scale to set the number
range on the vertical axis.

. Click OK.
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Operation Sheet-1 | opening MS-word

Objectives:
e To open and work on Microsoft word program
Procedures
The following steps are used to open MS-Word
Step 1: click start button located at the left corner of desktop window
Step 2: Point to all programs

Step 3: Open or point the folder labeled ‘Microsoft office’

Step 4: Finally select from the list of Microsoft programs that labeled ‘Microsoft Word’

LAP Test Working with MS-Word
Name: Date: -
Time started: Time finished:
Instructions:

1. You are required to perform any of the following:

1.1 Request your teacher to arrange a desktop computer.
1.2 Do the following activities by your own
a. Open Microsoft word window
b. Prepare some writing up to 500 letter and one table with a column and width
of 3 and 4 respectively
c. Work on your writing with font size 12,font style Times new roman, justified
and spacing with 1.5
1.3  Request your teacher for evaluation and feedback.
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Information Sheet-5 | Moving folders/subfolders and files

Copying and Moving Files and Folders
Copying means duplicating (producing) a copy of files while moving (Cut) a file is removing

it from its original position reside on the another location.

» To copy a file or folder:
1) Select the file or the folder->Right click on it > Copy
2) Ifitis opened program: - Edit-> Copy.
3) Open the folder or disk where you want to put the copy.
4) On the Edit menu or standard toolbar or from the pop-up menu click Paste.

Note: Use Ctrl + Left drag to force a copy.

Remark: To move a file or folder, follow the same procedure as copying except that instead
of clicking copy from the edit menu or standard tool bar to copy a file or folder,

click cut to move.

Note: - Use the left mouse button to drag the object from one folder to another on the same

drive.

- Use Shift + Left drag to force move.
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Self-Check -1 Written Test
Name: Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid

some explanations/answers.

1. How you copy files to a folder?

Note: Satisfactory rating - 10 points and above

You can ask your teacher for the copy of the correct answers.

Unsatisfactory - below 10 points

Answer sheet

Score =

Rating:

Information Sheet-5

Saving folders/subfolders and files in appropriate media

Copying a File to a compact disk, flash disk and Floppy Disk

» To copy a file or folder to a compact disk, flash disk and floppy disk or to other drivers

1) Insert the disk into the disk drives.

2) In My Computer and Explorer

Click the file you want to copy.

3) On the File menu, point of Send to and then select and click

Example click CD-R drive

Or - right click on the file to be copied.
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- Point to Send to and then click 3 %2 Floppy or other folders.

» To make a copy of a disk:

1. Click the icon for the disk you want to copy.

On the File menu, point to the Disk Copy and click Copy Disk.

In Copy From, click the drive you want to copy from.

2
3
4. In Copy To, click the drive you want to Copy to.
5

Click Start.

Self-Check -1

Written Test

Name:

Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid

Note: Satisfactory rating - 10 points and above

some explanations/answers.

What is flash disk ?

How can you send files to a flash disk ?

You can ask your teacher for the copy of the correct answers.

Unsatisfactory - below 10 points

Answer sheet

Score =

Rating:
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Operation Sheet-1

Copying file to a flash disk

Objectives:

e Tosend/copy a file an external storage drive such as flash disk

Procedures

The following steps are used to copy files to flash disk

Step 1: insert the flash to the computer with the space for flash

Step 2: right click on the file you want to send/copy to the flash

Step 3:point to send to

Step 4:select the name of your flash from the list

Step 5:when you select your flash the file will be sent
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Information Sheet-8 | Restoring deleted folder/sub folder and files

Deleting Files and Folders
Whenever you delete a file, it is temporarily moved to the Recycle Bin, on the Desktop. If
you need the files you have deleted, you can restore the files. However, when you empty

the Recycle Bin, all of the items in are permanently deleted from your computer.

» To delete a file temporarily :
Right click on deleted file or folder—=> Delete Or

Select the file you want to delete>press delete from the keyboard

» To delete files (temporarily) or moving them to Recycle Bin:

To retrieve deleted files:

Double-click the Recycle-Bin icon—> Click on the fie you want to retrieve—> Click

Restore

» To empty the Recycle Bin
1. Double-click the Recycle Bin.
2. Click Empty Recycle Bin.
» To delete files (permanently) or without moving them to Recycle Bin:
Select the file or folder to be deleted = Hold down the Shift Key or click Delete
pressing the Delete Kkey if you are using the keyboard
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Operation Sheet-1 Restoring deleted file/folder

Objectives:

e Understand how to retrieve deleted file

Procedures

Step 1: Double-click the Recycle-Bin icon
Step 2: Click on the file you want to retrieve

Step 3: Click Restore
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Instruction sheet

Learning Guide #72

This learning guide is developed to provide you the necessary information regarding the
following content coverage and topics:

e Printing information.

e Viewing and deleting progress of print jobs.

e Installing default printers

This guide will also assist you to attain the learning outcome stated in the cover

page. Specifically, upon completion of this Learning Guide, you will be able to:-

e Print information.

o View and delete progress of print jobs.

e Install default printers

Learning Instructions:

1.

Read the specific objectives of this Learning Guide.

2. Follow the instructions described
3. Read the information written in the information “Sheet
4. Accomplish each “Self-check respectively.
5. If you earned a satisfactory evaluation from the “Self-check” proceed to the next or
“Operation Sheet
6. Do the “LAP test”
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Information Sheet-1 Printing information

1.1 Print a Document

When we finalize our work either it be word or excel document and if we want to print out

the following simple steps can be followed:
Steps 1

Open or create a Microsoft Word document. To do so, click on the blue app with a white
document icon and bold "W," then click on File in the menu bar at the upper-left of the

screen. Click on Open... to open an existing document or New... to create a new one.

When you are ready to print, open the Print dialog box.

B 0 @ Filters \/
Best match

= Microsoft Office Word 2007
—'  Desktop app

Apps

" WordPad

Search suggestions

L word - see web result

Store

Step 2

Click on File. It's in the menu bar at the upper-left of the screen or a tab at the upper-left of

the window.
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Step 3

Click on Print.... The Print dialog box will open.

Step 4
Select your printing options. Use the selections in the dialog box to select:

¢ Your default printer is displayed. Click on its name to select another printer from the

drop-down menu.

e The number of copies to print. The default is 1; increase the quantity to print more

copies.
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e Which pages to print. The default is to print all the pages in the document, but you can
choose to print the currently-displayed page, a highlighted selection, specific pages in
the document, odd-numbered pages only, or even-numbered pages only.

e The size of paper to print on.

¢ The number of pages to print per sheet.

e Orientation of the paper. Select either Portrait (paper length vertical, width
horizontal) or Landscape (paper width vertical, length horizontal).

e Margins. You can adjust the top, bottom, left, and right margins with the labeled up

and down arrows or by typing numbers in the boxes.

‘Print ? X
eSS |
Printer
Name: Sp Adobe POF V. Properties
S e Find Printer...
Type: Adobe PDF Converter
Where:  Documents\*.pdf [ rint to file
Comment: [ Manual duplex
Page range Copies
(OF Number of copies: |1 o
O Current page Selection 1 1
O Pages: 1 1 Collate
Type page numbers and/or page "

ranges separated by commas counting
from the start of the document or the
section. For example, type 1, 3, 5-12 o
pisi, pis2, p1s3-pss3

Print what: | Document v Zoom

Print: All pages in range <] | Pegespersheet: |1 page V

Scale to paper size: | No Scaling v

Step 5

Click on Print or OK. The button label will vary based on the version of Word you're using.

Your document will print to the printer you selected.
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Name: | g Adobe POF

Status:  Idle

Type: Adobe PDF Converter
Where:  Documents\*.pdf
Comment:

Page range
@al

O pages:

plsl, pis2, pis3-pss3

Print: All pages in range

QO current page | Seedion

Typepagenmbersandlorpage
ranges separated by commas counting
from the start of the document or the
section. For example, type 1, 3, 5-12 or

T
|3

Number of copies: li

@; o

Pages per sheet: page
Scale to paper size: | No Scaling

II

af

Self-Check -1

Written Test

Name:

Date:

Directions: Answer all the questions listed below. [llustrations may be necessary to aid
some explanations/answers.

Name:

Time started:

Date:

Instructions:

Time finished:

1. You are required to perform any of the following:

1.4 Request your teacher to arrange
1.5 Request your teacher for evaluation and feedback.
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Information Sheet- | nstalling default printers

1. Click on the Windows button on the taskbar

2. Click on Devices and Printers

=, t

*‘ Remote Desktop Connection > o
% Snipping Tool Gonzalez, Ariel
:'[ Paint N Documents

Pictures
.,ﬂ Notepad »
a1 Music
w‘ Microsoft Word 2010 >

Computer
Sticky Notes 4

Control Panel
" Mozilla Firefox 3

Devices and Printers
@ iTunes

Default Programs

Help and Support

| 2l Programs

Search programs and files el ‘ ' own | > '

2 AARDEIFREID

3. Once the window opens, look over the list of printers that are available to you. The

printer with the green check mark on it is the current default printer.
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C118-RICOH

4. Once you locate the printer you want like to set as your default, right click on the

printer icon, select Set as default printer

(CNC) [ > Conmat Panoi » Hartasee anc Soune » v and Partees » = s |
Addadewce  AGGapnnlr  SoowMANIpANENg Prinksover froperbes  Komoue dence
4 Printers and | ees (58)
Bie %) Zrre | oy ey Beo
# g n 2 L . [}
ALLC-RICOH ALLZ-PRINTER AL13-RICOH A210-RICOH AZLIA-RICOH AJLO-RICOH A312-RCOH
{ / Bevs, E L, =
ALEDRICON  Adobe DT 3500 [ BA4S-CO |
P S
X | 27m 20 - .
P =P =i » ~,
CUB-RCOI  C223-RICOH Ca20-nacoil c 0036-RICCH

5. The printer you chose should be selected as the default printer similar to the

example shown.

(I (=4 Control Panci + Hordware and Sound » Devices and Pinters » <] | Search beces and priecs P

Addadece  Addapinler  Seewhalspiniing  Prnt senver properies  Remove device - @

b s
CL18-RICOH C223-RICOH €320-RICOH C423-RICOH D137-RICOH D335A-RICOH D338-RICOH
i » g > =

T
) -
72 P ay Sy
AN ARKOn e GEPACON  GITAKO4  GURCRKON  GIR-RKoN

Status: 0 documentls) in queue

g €118 RICOH
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Instruction sheet Learning Guide #73

This learning guide is developed to provide you the necessary information regarding the

following content coverage and topics:

e Closing all open applications

e Shutting down a computer

This guide will also assist you to attain the learning outcome stated in the cover

page. Specifically, upon completion of this Learning Guide, you will be able to:-

e Closing all open applications
e Shutting down a computer
Learning Instructions:
1. Read the specific objectives of this Learning Guide.
Follow the instructions described
Read the information written in the information “Sheet

2
3
4. Accomplish each “Self-check respectively.
5

If you earned a satisfactory evaluation from the “Self-check” proceed to the next or

“Operation Sheet
6. Do the “LAP test”
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Information Sheet-  ghytting down a computer

» To avoid damaging programs, always shutdown windows (the programs you
opened) before you turn off your Computer.

» Simple steps to follow when shutting down a Computer:

Step 1: To shut down your computer, click "Start" on the main menu.
Step 2: Highlight and click on "Shut Down."
Step 3: You will see a gray dialogue box. Click "Shut Down," then click "OK."

Step 4: Please wait while your computer shuts down.

Self-Check -1 Written Test

Name: Date:

Directions: Answer all the questions listed below. Illustrations may be necessary to aid
some explanations/answers.

1. Write down the steps to shutdown a computer
Note: Satisfactory rating - 10 points and above Unsatisfactory - below 10 points

You can ask your teacher for the copy of the correct answers.

Answer sheet

Score =

Rating:
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